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MÔN TOÁN HỌC  

A . KIẾN THỨC CẦN NHỚ 

I. Đại số:  

1. Hệ phương trình, cách giải hệ pt 

2. Tính chất của hàm số 2y ax  (a ≠ 0). Đồ thị của hàm số 
2y ax  (a ≠ 0). 

3. PT bậc hai một ẩn: ĐN, công thức nghiệm, công thức nghiêm thu gọn. 

4. Hệ thức Vi –ét và ứng dụng. 

5. Giải bài toán bằng cách lập PT và hệ PT 

II. Hình học: 

1. Ôn tập các góc với đường tròn. 

2. Định nghĩa, tính chất, dấu hiệu nhận biết tứ giác nội tiếp. 

3. Các khái niệm và định lý chương 2, chương 3 liên quan tới đường tròn. 

B. CÁC DẠNG BÀI TẬP: 

Dạng 1: Biến đổi biểu thức 

Bài 1 : Cho biểu thức 
2

1

x
A

x




              

4
B

11

x x

xx


 


 

1) Tính giá trị của A khi 
1

16
x   

2) Rút gọn biểu thức P = 
A

B
 

3) Tìm các giá trị của x để 
1

2
P    

4) Tìm x để ( 2) 5 8P x x x     

5) Tìm x để 2P x  

6) Tìm GTNN của P  

7) Tìm x N để P đạt giá trị nhỏ nhất 

8) Tìm giá trị lớn nhất của  M = 
3

.
1

x
P

x




 

9) Tìm giá trị nguyên của x để P nhận giá trị là số nguyên 

10) Tìm x để 3P nhận giá trị là số nguyên  

11) So sánh P với P2 

12) Tìm x để ( 2) 2 1 2x 2 2x 1P x x x        

13) Tìm m để có x thỏa mãn P = 
1

m
. 

Dạng 2: Phương trình, hệ phương trình  

Bài 1. Giải các phương trình và hệ phương trình sau: 

a) 
( 1)( 1) 1

( 3)( 3) 3

x y xy

x y xy

   


   
               b) 

2(3 2) 4 5(3 2)

4(3 2) 7(3 2) 2

x y

x y

   


    
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c) 
3 2 2 3 5

2 2 3 1

x y

x y

    


   

                            d) 

1 3
4

1 3 1

1 4
3

3 1 1

x y

y x


   


  
  

  

e) 
2 2 2 1 0x x              f) 

4 23 2 0x x             g) 
3 23 2 0x x x     

Bài 3. Cho hệ phương trình 
4 10

4

mx y m

x my

  


 

   ( m là tham số) 

a) Tìm m để hệ có nghiệm duy nhất? Vô nghiệm? Vô số nghiệm? 

b) Xác định các giá trị nguyên của m để hệ có nghiệm duy nhất (x ; y) sao cho xy > 0 

c) Với giá trị nào của m thì hệ có nghiệm (x ; y) với x, y là các số nguyên dương. 

Bài 4: Cho hệ phương trình 








122

12

mmyx

mymx
 

1) Giải hệ phương trình khi m = 1. 

2) Tìm m để hệ có nghiệm là (3; 2)? 

3) Tìm m để hệ có nghiệm duy nhất (x, y) thỏa mãn: 

a) x, y trái dấu 

b) x, y cùng dương 

c) x + y = 3. 

d) 
1

7
x y

m
 


 

e) 2x y   

f) 2x + y > 3 

Bài 5. Cho phương trình  2x 2 m 1 x m 4 0,      m là tham số 

a) Giải phương trình khi x = - 5  

b) CMR phương trình luôn có nghiệm 1x ,  2x  với mọi m. 

c) Tìm m để phương trình có hai nghiệm trái dấu. 

d) Tìm m để phương trình có hai nghiệm dương. 

f) CMR biểu thức    1 2 2 1A x 1 x x 1 x     không phụ thuộc m 

Bài 6. Cho phương trình ẩn x: 2( 4) 2 2 0m x mx m       

a) Giải phương trình khi m = 5 

b) Tìm m để phương trình có nghiệm 2x  . Tìm nghiệm còn lại. 

c) Tìm m để phương trình: có nghiệm? Có 2 nghiệm phân biệt? Vô nghiệm? Có nghiệm 

kép? 

d) Khi phương trình có nghiệm 
1 2,x x : + Hãy tính 2 2

1 2A x x   theo m? 

                                                               + Tìm m để A =1 

Dạng 3: Hàm số và đồ thị 

Bài 7. Cho hàm số (P) : y = x2 

a) Vẽ đồ thị của hàm số (P). 

b) Xác định tọa độ A,B là giao điểm của (P) với đường thẳng y =2x +3. 
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c) Gọi C, D lần lượt là hình chiếu của A và B. Tính chu vi và diện tích của tứ giác ABDC. 

d) Lập phương trình đường thẳng đi qua điểm M(2; 4) có hệ số góc a và tiếp xúc với (P). 

Bài 8. Cho hàm số (P) y = x2  và đường thẳng (d) : y = mx + m + 1 

a) Tìm tọa độ giao điểm của (P) và (d) khi m = - 3. 

b) Tìm m để (d) cắt (P) tại 2 điểm phân biệt. 

c) Tìm m để (d) cắt (P) tại 2 điểm phân biệt thỏa mãn |x1 – x2| = 2. 

d) Tìm m để (d) cắt (P) tại 2 điểm phân biệt thỏa mãn tổng tung độ của hai giao điểm bằng 

5. 

e)  Tìm m để (d) cắt (P) tại 2 điểm phân biệt nằm về hai phía của trục tung. 

f) Tìm m để (d) đi qua điểm M nằm trên (P). Biết điểm M có hoành độ bằng – 2 . 

Dạng 4. Giải bài toán bằng cách lập phương trình, hệ phương trình. 

Bài 9. Tìm hai số tự nhiên biết rằng hiệu của chúng bằng 1275 và nếu lấy số lớn 

chia cho số nhỏ thì được thương là 3 và số dư là 125. 

Bài 10. Hai công nhân nếu làm chung một công việc thì mất 40 giờ. Nếu người thứ 

nhất làm 5 giờ và người thứ hai làm trong 6 giờ thì hoàn thành 
2

15
 công việc. Hỏi nếu 

mỗi người làm riêng thì mất bao nhiêu giờ mới hoàn thành công việc? 

Bài 11. Hai tổ sản xuất cùng may một loại áo. Nếu tổ I may trong 3 ngày và tổ II 

may trong 5 ngày thì hai tổ may được 1310 áo. Biết rằng mỗi ngày tổ I may nhiều hơn tổ 

II là 10 cái áo. Hỏi một ngày mỗi tổ may được bao nhiêu áo? 

Bài 12. Trong tháng thứ nhất hai tổ sản xuất được 540 sản phẩm. Do cải tiến kĩ 

thuật nên sang tháng thứ hai , Tổ I đã vượt mức 20% và tổ II đã vượt mức 15%. Vì vậy 

tháng thứ hai cả hai tổ sản xuất được 632 sản phẩm. Hỏi trong tháng thứ nhất mỗi tổ sản 

xuất được bao nhiêu sản phẩm. 

Bài 13. Lúc 6 giờ 30 phút một người đi xe máy từ A đến B dài 75km với vận tốc 

định trước. Đến B người đó nghỉ lại 20 phút rồi mới quay về A với vận tốc lớn hơn vận 

tốc lúc đi 5km/h. Người đó về đến A lúc 12 giờ 20 phút. Tính vận tốc của người đo lúc 

đi từ A đến B. 

Bài 14. Một ô tô đi quãng đường AB với vận tốc 50km/h, rồi đi tiếp quãng đường 

BC với vận tốc 45km/h. Biết tổng chiều dài quãng đường AB và BC là 165km và thời 

gian ô tô đi quãng đường AB ít hơn thời gian ô tô đi quãng đường BC là 30 phút. Tính 

thời gian ô tô đi trên quãng đường AB, BC. 

Dạng 5. Hình học tổng hợp 

Bài 15: Cho tam giác ABC vuông tại A. Điểm D thuộc cạnh AB. Vẽ đường tròn 

(O) đường kính BD cắt BC tại E. Các đường thẳng CD, AE cắt đường tròn (O) lần lượt 

tại F và K. 

a) Chứng minh BC.BE = BD.BA. 

b) Chứng minh: Bốn điểm C, A, F, B thuộc một đường tròn. 

c) Chứng minh AFKC là hình thang; 

d) Chứng minh D là tâm đường tròn nội tiếp tam giác AEF. 
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Bài 16: Cho đường tròn (O; R) và dây CD cố định. Gọi H là trung điểm CD. Gọi 

S là một điểm trên tia đối của tia DC. Qua S kẻ hai tiếp tuyến SA, SB tới đường tròn (O). 

Đường thẳng AB cắt SO, OH lần lượt tại E và F. 

a) Chứng minh SEHF là tứ giác nội tiếp; 

b) Chứng minh OE.OS không phụ thuộc vị trí của đểm S trên tia đối của DC; 

c) Cho R = 10cm; SD = 4cm, OH = 6cm. Tính CD và SA; 

d) Chứng minh khi S di động trên tia đối của tia DC thì đường thẳng AB đi qua 

một điểm cố định; 

Bài 17: Cho đường tròn (O) đường kính AB = 2R. Điểm H thuộc đoạn OA. Kẻ dây 

CD vuông góc AB tại H. Vẽ đường tròn tâm I đường kính AH và đường tròn tâm K đường 

kính BH. Nối AC cắt đường tròn (I) tại E; nối BC cắt đường tròn (K) tại F. 

a) Chứng minh HECF là hình chữ nhật; 

b) Chứng minh tứ giác ABFE là tứ giác nội tiếp; 

c) EF cắt đường tròn (O) tại M và N. Chứng minh tam giác CMN cân. 

d) Tìm vị trí của điểm H để diện tích tứ giác CEHF lớn nhất. 

Bài 18: Cho tam giác ABC vuông tại A, đường cao AH. Vẽ đường tròn tâm O, 

đường kính AH, cắt AB, AC lần lượt tại M và N. Gọi I là trung điểm của BC. Chứng 

minh rằng: 

a) Ba điểm M; O; N thẳng hàng;  

b) BMNC là tứ giác nội tiếp; 

c) AI vuông góc với MN;     

d) BM.BA + CN.CA   2AH2 

Bài 19: Cho đường tròn tâm (O; R) và (O’; R’) cắt nhau tại A và H (O và O’ ở hai 

phía của AH). Vẽ các đường kính AOB và AO’C của hai đường tròn. Một đường thẳng 

d qua A cắt đường tròn (O) tại M, cắt (O’) tại N. A nằm giữa M và N. 

a)  Ba điểm B, H, C thẳng hàng; 

b)  Chứng minh rằng khi đường thẳng d thay đổi thì tỷ số 
HM

HN
 không đổi 

c)  Gọi I, K lần lượt là trung điểm của MN và BC. Chứng minh bốn điểm A, H, I, K 

thuộc một đường tròn. 

d)  Xác định vị trí của đường thẳng d để diện tích tam giác HMN lớn nhất. 

Bài 20: Cho đường tròn tâm (O; R) dây DC cố định. Điểm M thuộc tia đối của tia 

CD. Qua M kẻ hai tiếp tuyến MA, MB tới đường tròn (A thuộc cung lớn CD). Gọi I là 

trung điểm của CD. Nối BI cắt đường tròn tại E (E khác B). Nối OM cắt AB tại H. 

a) Chứng minh năm điểm M, A, O, I, B thuộc một đường tròn. 

b) Chứng minh AE // CD. 

c) Tìm vị trí của M để MA vuông góc với MB; 

d) Chứng minh HB là phân giác của góc CHD. 
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MÔN NGỮ VĂN 

 

I. KIẾN THỨC CẦN GHI NHỚ 

      1. Đọc hiểu văn bản: 

        - Mùa xuân nho nhỏ 

        - Viếng lăng Bác 

        - Sang thu 

        - Nói với con 

        2. Tiếng Việt: 

Các đơn vị kiến thức Tiếng Việt đã học, đặc biệt là thành phần biệt lập, Liên kết câu 

và đoạn văn 

3. Tập làm văn: 

  Viết đoạn văn nghị luận xã hội:  

- Nghị luận về một tư tưởng, đạo lí 

      - Nghị luận về một sự việc, hiên tượng trong đời sống. 

 Viết đoạn văn nghị luận văn học: cảm nhận, phân tích thơ; … 

II. CÁC DẠNG BÀI LUYỆN TẬP 

      1. Đọc hiểu văn bản + Tiếng Việt 

- Xác định tên văn bản, tên tác giả, xuất xứ, hoàn cảnh sáng tác, thể loại, nội dung, 

nghệ thuật,… 

- Trả lời câu hỏi đọc hiểu về một trích đoạn văn bản. 

- Trả lời một số câu hỏi về Tiếng Việt liên quan đến trích đoạn văn bản: 

 + Xác định, gọi tên một số yếu tố Tiếng Việt được sử dụng trong trích đoạn. 

 + Phân tích tác dụng của một biện pháp nghệ thuật trong trích đoạn.  

 v.v… 

2. Tập làm văn: 

 - Viết đoạn văn nghị luận phân tích đoạn thơ hoặc phân tích một chi tiết, hình ảnh… 

để làm rõ một khía cạnh nội dung hoặc nghệ thuật của văn bản. Trong đoạn có sử 

dụng một cách hợp lí, hiệu quả các yếu tố Tiếng Việt (gạch chân và chú thích rõ) 

 - Viết đoạn nghị luận xã hội khoảng 1 trang giấy kiểm tra. 

III. HƯỚNG RA ĐỀ: Theo cấu trúc đề thi vào lớp 10 

1. Phần I: Trả lời câu hỏi đọc hiểu về một trích đoạn văn bản đã học trong chương 

trình Ngữ văn 9, học kì 2; viết đoạn nghị luận văn học. 

2. Phần II: Trả lời câu hỏi đọc hiểu về một trích đoạn văn bản ngoài chương trình 

SGK; viết đoạn nghị luận xã hội. 
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MÔN TIẾNG ANH  

REVISION FOR THE MID-SEMESTER TEST - SEMESTER 2 

SCHOOL YEAR 2023 – 2024 

GRADE 9 

UNIT 7: RECIPES AND EATING HABITS  

VOCABULARY 

1. avocado /ˌævəˈkɑːdəʊ/  (n): bơ 

2. bake /beɪk/  (v): nướng 

3. beef noodle soup /biːf/ /ˈnuːdl/ /suːp/  : bún bò 

4. broccoli /ˈbrɒkəli/  (n): súp lơ 

5. chop /tʃɒp/  (v) : chặt 

6. cube /kjuːb/  (n) : miếng hình lập phương 

7. celery /ˈseləri/  (n): cần tây 

8. curry /ˈkʌri/  món cà ri 

9. deep-fry /ˌdiːp ˈfraɪ/  (v): rán ngập mỡ 

10. dip /dɪp/  (v): nhúng 

11. drain /dreɪn/  (v): làm ráo nước 

12. flatbread /ˈflætbred/  (n): bánh mì dẹt 

13. garnish /ˈɡɑːnɪʃ/  (v): trang trí (món ăn) 

14. grate /ɡreɪt/  (v) : nạo 

15. grill /ɡrɪl/  (v): nướng 

16. gravy /ˈɡreɪvi/  (n): nước thịt 

17. ingredient /ɪnˈɡriːdiənt/  (n): nguyên liệu 

18. kohlrabi /ˌkəʊlˈrɑːbi/  (n): cải xoăn 

19. lasagne /ləˈzænjə/  (n): mì ống xoắn 

20. lettuce /ˈletɪs/  (n): rau diếp 

21. marinate /ˈmærɪneɪt/  (v) /ˈmærɪneɪt/: ướp 

22. oven /ˈʌvn/  (n): lò nướng 

23. peel /piːl/  (v) : gọt vỏ, bóc vỏ 

24. puree /ˈpjʊəreɪ/  (v) : xay nhuyễn 

25. prawn /prɔːn/  (n): tôm 

26. pepper /ˈpepə(r)/  (n): tiêu, ớt 

27. roast /rəʊst/  (v) : quay 

28. sauce /sɔːs/  (n): nước sốt 

29. shallot /ʃəˈlɒt/  (n) : hành khô 

30. simmer /ˈsɪmə(r)/  (v) : om 

31. spread /spred/  (v): phết 

32. sprinkle /ˈsprɪŋkl/  (v) : rắc 

33. slice /slaɪs/  (v): cắt lát 

34. staple /ˈsteɪpl/  (n): lương thực chính 

35. starter /ˈstɑːtə(r)/  (n) : món khai vị 

36. steam /stiːm/  (v) : hấp 

37. stew /stjuː/  (v): hầm 

38. strip /strɪp/  (n): sợi, dải 

39. stir-fry /ˈstɜː fraɪ/  (v) : xào 

40. tender /ˈtendə(r)/  (adj) : mềm 

41. versatile /ˈvɜːsətaɪl/  (adj) : đa dụng 

42. whisk /wɪsk/  (v) : đánh (trứng…) 

43. wrap /ræp/  (v): gói 

 

GRAMMAR 

1. SOME AND ANY 

- SOME và ANY là hai tính từ chỉ số lượng bất định. Chúng được dùng trước danh từ không 

đếm được hoặc danh từ đếm được số nhiều. 

2.MODAL VERBS IN CONDITIONAL SENTENCES TYPE 1 

Động từ khuyết thiếu trong câu điều kiện loại 1. 

 
Note: Câu điều kiện này điều kiện có thể hoặc không thể thực hiện trong tương lai. 

 

1. SOME (MỘT VÀI, MỘT ÍT) 2. ANY (NÀO) 

- Some được dùng trong câu khẳng định và lời 

mời, yêu cầu 

- Any được dùng trong câu phủ định hoặc câu hỏi. 

Ex: Would you like some tea? (Bạn dùng một ít 

trà nhé?) 

Ex: Do you have any pens? (Bạn có chiếc bút nào 

không?) 

- Some đứng trước danh từ không đếm được 

hoặc danh từ đếm được số nhiều. 

- Any đứng trước danh từ không đếm được hoặc danh từ 

đếm được số nhiều. 

Ex: There are some butter. (Có một chút bơ) 

There are some eggs. (Có một vài quả trứng) 

Ex: There isn’t any butter. (Không có chút bơ nào cả.) 

Are there any eggs? (Có quả trứng nào không?) 

 

If - clause (Mệnh đề If) Main clause (Mệnh đề chính) 

If + S + V (present simple) S + will/ can/ may/ must + V (bare infinitive) 
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UNIT 8. TOURISM 

VOCABULARY 

1.speciality /ˌspeʃiˈæləti/ (n): đặc sản 

2.package tour /ˈpækɪdʒ tʊə/ (n.phr): du lịch trọn gói 

3.seaside /ˈsiːsaɪd/ (n) bờ biển 

4.one's cup of tea /wʌnz kʌp əv tiː/ (n.phr): sở thích 

5.make up one’s mind /ˈmeɪk ˈʌp jə maɪnd/ 

= decide to V/ make a decision 

(adj): quyết định 

6.reserve /ri'zə:v/ = book(v) (v): đặt trước 

7. expe’dition /,ekspi'di∫n/ (n): chuyến thám hiểm 

8.reasonable /ˈriːznəbl/ (adj): hợp lý ( giá cả phải chăng) 

9. excursion /ɪkˈskɜːʃn/ (n): chuyến du ngoạn 

10. peak season /piːk ˈsiːzn̩/ >< low season  (n): mùa cao điểm 

11.stopover /ˈstɒpəʊvə(r)/ (n): điểm dừng chân 

12.pile-up /ˈpaɪlʌp/ (n): vụ đâm xe 

13.touchdown /ˈtʌtʃdaʊn/ = land (v) 

>< take off (v): cất cánh 

(n): hạ cánh 

14.full board /ˈfʊl bɔːd/ (n.phr) ăn ngủ trọn gói 

15. mix-up /ˈmɪksʌp/ = confuse(v) (n.phr): nhầm lẫn 

16.checkout /ˈtʃekaʊt/ >< check in  (n.phr): thủ tục thanh toán 

1. semi-desert /ˈsemi ˈdezət/ (n): vùng nửa sa mạc 

18. plain /pleɪn/ (n): đồng bằng 

19.lush /lʌʃ/ (adj): tươi tốt, sum sê 

20.break the bank /ˈbreɪk ðə bæŋk/ v.phr): tiêu tốn nhiều tiền 

21.cuisine /kwɪˈziːn/ (n): ẩm thực 

22.magnificence /mæɡˈnɪfɪsns/ = feature (n) (n): điểm nổi bật 

23.erode away /ɪˈroʊd əˈweɪ/ (v.phr): xói mòn 

24.stalagmite /ˈstæləɡmaɪt/ (n): măng đá 

25.access /ˈækses/ (v) :có liên kết, kết nối 

26.economic growth /ˌekəˈnɑːmɪk ɡroʊθ/ (n.phr): sự phát triển kinh tế 

27.widespread /ˈwaɪdspred/ (adj): rộng rãi 

28.prosperity /prɒˈsperəti/ = wealthy (adj) (n): sự thịnh vượng, giàu có 

29.promote /prəˈməʊt/ = develop(v) v): thúc đẩy, phát triển 

30.safari /səˈfɑːri/ (n): cuộc đi săn 

31.holidaymaker /ˈhɒlədeɪmeɪkə(r)/ (n): người đi nghỉ dưỡng 

32.return ticket /rɪˈtɜːnˈtɪkɪt/ (n): vé khứ hồi 

33.round-trip /ˌraʊnd ˈtrɪp/ n): chuyến đi khứ hồi 

GRAMMAR 

1.INDEFINITE ARTICLES: A/ AN 

- An đứng trước 1 danh từ đếm được số ít bắt đầu bằng 1 nguyên âm (u, e, o, a, i). 

- A đứng trước danh từ đếm được số ít bắt đầu bằng 1 phụ âm. 

1.1. A/ An được dùng trước: 
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1.2.A/ An không được dùng: 

 
II. DEFINITE ARTICLE: THE 

1.3. THE được dùng trước: 

 

 
1.4. THE không dùng được 

- Trước các danh từ số nhiều nói chung Ex: They build houses near the hall. 

- Danh từ trừu tượng, không đếm được Ex: Independence is a happy thing. 

- Các danh từ chỉ màu sắc Ex: Red and white make pink. 

- Các môn học Ex: Math is her worst subject. 

- Các vật liệu, kim loại Ex: Steel is made from iron. 

- Danh từ đếm được, số ít. 

*An: đứng trước nguyên âm hoặc “h” câm. 

Ex: a doctor, a bag, an animal, an hour....... 

Ex: an animal, an hour.......  

- Trong các cấu trúc: 

so + adj + a/an + noun 

such + a/an + noun 

as + adj + a/an + noun + as 

How + adj + a/an + noun + verb! 

 

Ex: 

- It’s such a beautiful picture. 

- She is as pretty a girl as her sister. 

- How beautiful a girl you are! 

- Chỉ một người được đề cập qua tên. Ex: A Mrs. Blue sent you this letter. 

- Trước các danh từ trong ngữ đồng vị. Ex: Nguyen Du, a great poet, wrote that novel. 

- Trong các cụm từ chỉ số lượng. Ex: a pair, a couple, a lot of, a little, a few, a large/great 

number of..........  

 

- ONE được sử dụng thay A/An để nhấn mạnh. Ex: There is a book on the table, but one is not enough. 

- Trước danh từ không đếm được. Ex: Coffee is also a kind of drink. 

- Trước các danh từ đếm được số nhiều. Ex: Dogs are faithful animals. 

 

- Những vật duy nhất Ex: the sun, the moon, the world.... 

- Các danh từ được xác nhận bởi cụm tính từ 

hoặc mệnh đề tính từ 

- The house with green fence is hers. 

- The man that we met has just come. 

- Các danh từ được xác định qua ngữ cảnh hoặc 

được đề cập trước đó 

Ex: Finally, the writer killed himself. 

- I have a book and an eraser. The book is now on the table. 

- Các danh từ chỉ sự giải trí ... Ex: the theater, the concert 

 

- Trước tên các tàu thuyền, máy bay Ex: The Titanic was a great ship. 

- Các sông, biển, đại dương, dãy núi 
Ex: the Mekong River, the Pacific Ocean, the Himalayas 

- Một nhóm các đảo hoặc quốc gia Ex: the Philippines, the United States 

- Tính từ dùng như danh từ tập hợp Ex: You should help the poor. 

- Trong so sánh nhất Ex: Nam is the cleverest in his class. 

- Tên người ở số nhiều (chỉ gia đình) Ex: The Blacks, The Blues, the Nams 

- Các danh từ đại diện cho 1 loài Ex: The cat is a lovely home pet. 

- Các hạng từ chỉ thời gian, nơi chốn Ex: in the morning, in the street, in the water .. 

- Số thứ tự Ex: the first, the second, the third.... 

- Chuỗi thời gian hoặc không gian Ex: the next, the following, the last... 
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- Các tên nước, châu lục, thành phố Ex: Ha Noi is the capital of VietNam. 

- Các chức danh, tên người Ex: President Bill Clinton, Ba, Nga 

- Các bữa ăn, món ăn, thức ăn Ex: We have rice and fish for dinner. 

- Các trò chơi, thể thao Ex: Football is a popular sport in VN. 

- Các loại bệnh tật Ex: Cold is a common disease. 

- Ngôn ngữ, tiếng nói Ex: English is being used everywhere. 

- Các kỳ nghi, lễ hội Ex: Tet, Christmas, Valentine... 

- Các mũi đất (nhô ra biển, hồ, núi) Ex: Cape Horn, Lake Than Tho, Mount Cam, 

Mount Rushmore.... 

*But: the Cape of Good Hope, the Great Lake, 

the Mount of Olive.... 

 

2. CONDITIONAL SENTENCE - TYPE 2: PRESENT UNREAL (Diễn tả tình huống không có 

thật ở biện tại) 

 
Ex: I don't win a lot of money, so I can’t spend most of it travelling round the world. 

 → If I won a lot of money, I could spend most of it travelling round the world. 

 

UNIT 9. ENGLISH IN THE WORLD 

VOCABULARY 

1. approximately (adv) /əˈprɒksɪmətli/ xấp xỉ 

2. accent (n) /ˈæksent/ chất giọng 

3.simplicity (n)  /sɪmˈplɪsəti/ sự đơn giản 

4. operate (v) /ˈɒpəreɪt/ đóng vai trò 

5. dialect (n) /ˈdaɪəlekt/ tiếng địa phương 

6. technical term  (n) /ˈteknɪkəl tɜːm/  thuật ngữ chuyên môn 

7. spot on (n) /spɒt ɒn/ chinh xác 

8. bilingual (n) /ˌbaɪˈlɪŋɡwəl/ song ngữ 

9. pick up a language  /ˈpɪk ˈʌp ə 

ˈlæŋɡwɪdʒ/ 

học một ngôn ngữ bằng cách thực hành 

nó thay vì học trên lớp 

10. rusty (adj) /ˈrʌsti/ giảm đi do lâu không thực hành 

11. get by in a language  biết sơ sơ - biết vừa đủ một ngôn ngữ để 

giao tiếp đơn giản) 

12. be bilingual in  the language  thành thạo 2 thứ tiếng 

13. be reasonably good at the 

language 

 giỏi về ngôn ngữ 

14. be fluent in the language   thành thạo ngôn ngữ 

15 .imitate  (v) /ˈɪmɪteɪt/ bắt chước 

16.settlement (n) /ˈsetlmənt/  định cư 

17.immersion (n) /ɪˈmɜːʃn/ phương pháp dạy ngôn ngữ với những 

tình huống thiết thực 

18.derivative  (n) /dɪˈrɪvətɪv/ ngôn ngữ vay mượn 

19.dominant (adj) /ˈdɒmɪnənt/ thống trị, vượt trội 

20. first language = mother 

tongue(n) 

 Ngôn ngữ mẹ đẻ 

 

If + S + V (past subjunctive/ simple past), S + would/ could/ might + V. 
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GRAMMAR 

1.RELATIVE CLAUSES (MỆNH ĐỂ QUAN HỆ) 

A. BẢNG TÓM TẮT 

 

 
B. RELATIVE PRONOUNS (ĐẠI TỪ QUAN HỆ) 

Who: dùng để thay thế cho danh từ chỉ người, làm chủ ngữ trong mệnh đề quan hệ 

Ex: The man is Mr. Pike. He is standing over there. => The man who is standing over there is Mr. 

Pike. 

      Whom: dùng để thay thế cho danh từ chỉ người, làm tân ngữ trong mệnh đề quan hệ 

Ex: That is the girl I told you about her. => That is the girl whom I told you about. 

- Note: Whom làm tân ngữ có thể được bỏ đi trong mệnh đề quan hệ xác định. 

      Which: which dùng để thay thế cho danh từ chỉ vật, làm chủ ngữ hoặc tân ngữ trong mệnh đề quan hệ. 

Ex: The dress is very beautiful. I bought it yesterday. 

=> The dress which I bought yesterday is very beautiful. 

- Note: Which làm tân ngữ có thể được bỏ đi trong mệnh đề quan hệ xác định. 

      3.4. That: là đại từ chỉ cả người và vật, đứng sau danh từ để làm chủ ngữ hoặc tân ngữ trong mệnh đề 

quan 

      hệ. Ex: This is the book. I like it best. => This is the book that I like best. 

- Note: + Sau dấu phẩy không bao giờ dùng That 

 + That luôn được dùng sau các danh từ hỗn hợp (gồm cả người lẫn vật) everything, something, 

anything, all little, much, none và sau dạng so sánh nhát 

      3.5. Whose: là đại từ quan hệ chỉ sở hữu. Whose đứng trước danh từ chỉ người hoặc vật và thay thế 

cho tính từ sở hữu hoặc sở hữu cách trước danh tù. Sau whose là danh từ. 

Ex: John found a cat. Its leg was broken. => John found a cat whose leg was broken. 

4. RELATIVE ADVERBS (TRẠNG TỪ QUAN HỆ) 

      4.1.When: dùng để thay thế cho danh từ chỉ thời gian, When được thay cho at/on/ in + danh từ thời 

gian 

       hoặc then. -> Ex: May Day is a day. People hold a meeting on that day. 

      4.2. Where: dùng để thay thế cho danh từ chỉ nơi chốn, Where được thay cho at/on/ in + danh từ nơi 

chốn 

       hoặc there. Ex: Do you know the country? I was born. => Do you know the country where I was 

born? 

4.3.Why: dùng để thay thế cho danh từ chỉ lí do. Why thay cho for which. 

Ex: I don’t know the reason. She left him alone. => I don’t know the reason why she left him alone. 

 

Relative pronoun 

(Đại từ quan hệ) 

Noun replaced 

(Danh từ được thay thế) 

Functions 

(Chức năng) 

Who Danh từ chỉ người Làm chủ ngữ 

Whom Danh từ chỉ người Làm tân ngữ 

Which Danh từ chỉ vật Làm chủ ngữ hoặc tân ngữ 

That 
Danh từ chỉ người, vật, thay thế cho “who, 

whom, which” trong mệnh đề hạn định 
Làm chủ ngữ hoặc tân ngữ 

Whose Tính từ sỡ hữu hoặc sỡ hữu cách Làm chủ ngữ hoặc tân ngữ 

Where Danh từ chỉ nơi chốn Làm tân ngữ 

When Danh từ chỉ thời gian Làm tân ngữ 

Why Danh từ chỉ lí do Làm tân ngữ 
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UNIT 10: SPACE TRAVEL 

VOCABULARY 

1.mission (n) /ˈmɪʃn/ chuyến đi, nhiệm vụ 

2. astronaut (n) /ˈæstrənɔːt/ phi hành gia 

3. spacewalk (n) /ˈspeɪswɔːk/ chuyến đi bộ trong không gian 

4. meteorite (n) /ˈmiːtiəraɪt/ thiên thạch 

5. roller-coaster (n) /ˈrəʊlə kəʊstə(r)/ tàu lượn siêu tốc 

6. telescope(n) /ˈtelɪskəʊp/ kính thiên văn 

7. spacecraft  /ˈspeɪskrɑːft/ tàu vũ trụ 

8. microgravity  /ˌmaɪkrəʊˈɡrævɪti/ không trọng lực 

9. shuttle /ˈʃʌtl/  con thoi 

10. altitude  /ˈæltɪtjuːd/ độ cao (so với mặt biển) 

11. orbit  /ˈɔːbɪt/ xoay quanh, đi theo quỹ đạo 

12. land  /lænd/  hạ cánh 

13. launch  /lɔːntʃ/ phóng 

14. atmospheric   /ˌætməsˈferɪk/ (v): không khí, [thuộc] khí 

quyển 

15. groundbreaking  /ˈɡraʊndbreɪkɪŋ/ đột phá 

16. float around (v) /fləʊt əˈraʊnd/ trôi nổi 

17. unsustainable (adj) /ˌʌnsəˈsteɪnəbl/ không bền vững 

18. telecommunication /,telikə,mju:ni'kei∫nz/ viễn thông 

GRAMMAR 

 Mệnh đề quan hệ xác định: 

           Có 2 loại mệnh đề quan hệ: mệnh đề quan hệ xác định (defining/ restrictive relative clause) và mệnh đề 

không xác định (non-defining/ non-restrictive relative clause) 

       Mệnh đề quan hệ xác định dùng để đưa thêm thông tin cần thiết về người hoặc vật đang được nói tới. 

Thông tin này là cần thiết, bắt buộc phải có để chúng ta hiểu cái gì hoặc ai đang được nói tới. 

Ví dụ: Mệnh đề quan hệ bổ sung ý nghĩa cho chủ ngữ: “The man who keeps the school library is Mr 

Green.” 

Mệnh đề quan hệ bổ sung ý nghĩa cho tân ngữ: “That is the book that I like best.” 

EXERCISES FOR PRACTICE 

PHONETICS 

Find the word which has a different sound in the underlined part. 

1. A. island B. pilgrim C. surprising D. shrine 

2. A. sculpture B. structure C. future D. culture 

3. A. complex B. citadel C. cavern D. contestant 

4. A. pleasure B. measure C. treasure D. great 

5. A. aging B. cavern C. cave D. ancient 

6. A. tender B. garnish C. drain D. sprinkle 

7. A. grill B. garnish C. dip D. slice 

8. A. head B. spread C. cream D. bread 

9. A. sauce B. steam C. sugar D. stew 

10. A. marinate B. grate C. shallot D. staple 

Choose the word which has a different stress pattern from the others. 

1. A. safari B. breathtaking C. traveller D. sightseeing 

2. A. vacation B. delicious C. excursion D. holiday 

3. A. original B. stimulating C. imperial D. geography 

4. A. magnificence B. destination C. affordable D. accessible 
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5. A. provide B. bilingual C. immersion D. rusty 

6. A. simplicity B. American C. obedient D. flexible 

7. A. ingredient B. traditional C. repeat D. avocado 

8. A. celery B. benefit C. engineer D. versatile 

9. A. tender B. simmer C. cucumber D. delicious 

10. A. significant B. diverse C. garnish D. combine 

VOCABULARY AND GRAMMAR 

Choose the best answer ( A, B, C or D) 

1. A healthy diet is essential ________ good health and nutrition. 

 a. of b. in c. for d. towards 

2. Then add some black pepper ________ the salad dressing. 

 a. to b. on c. in d. with 

3. If you ________ food, you crush it so that it almost turns into liquid. 

 a. steam b. stir-fry c. grill d. puree 

4. Adding a small ________ of salt to a cup of bitter coffee will help cut the bitterness. 

 a. pinch b. cup c. bag d. handful 

5. You ________ feel more energized if you reduce your salt intake. 

 a. should b. may c. must d. would 

6. A: Is there some butter I could use? 

 B: No, there isn’t ________ butter, but some margarine. 

 a. some b. any c. little d. few 

7. Too much salt can lead to high blood pressure, ________ puts us at risk of stroke. 

 a. what b. when c. which d. that 

8. Recipes tell me to add one or two ________ of celery to a soup or stew. 

 a. cloves b. slices c. bunches d. sticks 

9. She added a potato to her overly salty soup ________ make it less salty. 

 a. so that b. as a result of c. in order to d. so as not to 

10. “I’ll make steak pie for dinner.” “ ________” 

 a. I’d love to. b. You’re right. c. Please, do it. d. Great! I can’t wait. 

11. He’s really _______ community tourism because he wants to experience local culture, 

 a. of b. with c. onto d. into 

12. I have _______ to four tourist attractions that need to be visited this year. 

 a. pulled it down b. broken it out c. shrunk it from d. narrowed it down 

13. Package tour isn’t my _______. I prefer independent travel. 

 a. hot potatoes b. piece of cake c. cup of tea d. flesh and blood 

14. I didn’t know that _______ Lake Michigan was one of the Great Lakes until last year. 

 a. a b. an c. Ø d. the 

15. You couldn’t possibly visit Paris without seeing _______ Eiffel Tower. 

 a. the b. a c. an d. Ø 

16. I will have a _______ summer holiday in Dubai where my sister works as a tour guide. 

 a. two-weeks b. two-week c. two weeks’ d. two week’s 

17. A long flight of stairs made the center _______ to disabled visitors. 

 a. unavailable b. unaffordable c. disadvantaged d. inaccessible 

18. The _______ happened in thick fog and caused a seven-mile tailback on the motorway. 

 a. pile-up b. touchdown c. mix-up d. jet lag 

19. Make sure you book tickets _______ because it costs more at the airport! 

 a. by chance b. at a price c. in advance d. for a start 

20. “I’m going to France for my summer holiday.” “_______” 

 a. Lucky you! b. Good idea! c. OK. Cool! d. Oh my God! 
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21.  The article was about the different varieties ______ English spoken throughout the world, 

 a. in b. of c. from d. among 

22. Susan ______ a bit of Spanish when she was living in Mexico. 

 a. looked up b. got by in c. picked up d. took in 

23. English grammar is said to be difficult to learn ______ its countless rules and numerousexceptions to 

them. 

 a. thanks to  b. in spite of  c. because of  d. provided that 

24. You don’t need to interrupt your reading to look up every unfamiliar word right away- it’s better to 

_______ first. 

 a. master b. imitate c. translate d. guess 

25. _______ education is the use of two different languages in classroom instruction. 

 a. Vocational b. Bilingual c. Monolingual d. Cooperated 

26. New York, _______ population reached 10 million by 1930, was the world’s first megacity. 

 a. whose b. which c. where d. of which 

27. Even though I spoke English, sometimes I didn’t understand the _______ of some areas because some 

words meant something else. 

 a. accent b. pronunciation c. dialect d. derivative 

28. The man with _______ I dined last night will be the next President of Bigfoot. 

 a. whom b. who c. which d. that 

29. _______, it was also adapting and absorbing vocabulary from elsewhere. 

 a. Although English was spreading b. As English was spreading 

 c. As long as English spread d. Because of the spread of English 

30. “What is the longest English word that doesn’t contain a vowel? I’d say tsktsks.” 

 “__________” 

 a. How come?  b. Sound exciting!  c. Spot on. d. Of course, it is. 

31. It is predicted that humans will fly to Mars _______ a discovery mission. 

 a. with b. on c. under d. for 

32. There have been no manned missions to the moon’s surface _______ 1972. 

 a. since b. in c. for d. from 

33. Mars might have been _______ between 3.8 and 3.1 billion years ago. 

 a. habitat b. habitual c. habitable d. habitation 

34. Edwin Hubble was the astronomer for _______ the Hubble Space Telescope is named, 

 a. which b. who c. that d. whom 

35. _______ water does not flow in a zero-gravity environment, the astronauts cannot wash their hands 

under a faucet. 

 a. Although  b. If c. When d. Since 

36. There are now countless _______ orbiting the earth for telecommunications, and other purposes. 

 a. spacecrafts b. rockets c. satellites d. telescopes 

37. Microgravity is the condition _______ people or objects appear to be weightless. 

 a. which b. where c. whose d. in which 

38. I’m very careful about what I eat so it’s only _______ I eat fast food. 

 a. over the moon  b. once in a blue moon 

 c. out of this world  d. the sky’s the limit 

39. The man sitting next to me on the plane _______ very nervous because he _______ before. 

 a. was - never flew  b. had been - didn’t fly 

 c. had been - hadn’t flown d. was - had never flown 

40. “Do you think we will travel to Mars in 15 years?” 

 “_______ But there’s positive signs.” 

 a. I’m not so sure.  b. Sounds interesting! 

 c. It’s wonderful.  d. Yes, why not? 
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Mark the letter A, B, C or D on your answer sheet to indicate the word(s) CLOSEST in meaning to 

the underlined word(s) in each of the following questions. 

1. Anyone can apply to train as an astronaut. 

A. mission  B. cosmonaut  C. astronomy  D. satellite 

2. Astronauts are required to complete a special training program before flying into the space. 

A. advised  B. suggested   C. obliged  D. opposed 

3. English is compulsory in most schools in our town. 

A. required  B. fulfilled   C. specialized D. applied 

4. Let’s wait here for her. I’m sure she will turn up before long. 

A. enter  B. arrive   C. return  D. visit 

5. We will join in activities to improve our self-care skills. 

A. participate B. take part in C. interested in D. take in 

6. He was able to incorporate a multimedia slideshow into the lesson plan despite the school’s lack of 

equipment because his friend lent him a multimedia projector. 

 A. include B. determine C. bestow D. propose 

7. NASA has recently discovered something new about Mars. 

A. lived on   B. narrowed down  C. found out  D. got into 

8. What has been the most challenging experience in your life as an astronaut, Mr. Tuan? 

A. lucky   B. easy   C. difficult  D. dangerous 

9. You shouldn’t walk at night alone in this area. It’s very dangerous. 

A. entertaining            B. unsafe            C. convenient                D. crowded 

10. I hope to come back to New Zealand one day in the future. 

A. go to                          B. visit           C. return                        D. see 

D.Mark the letter A, B, C, or D on your answer sheet to indicate the word(s) OPPOSITE in meaning 

to the underlined word(s) in each of the following questions. 

1. He’s been a bit depressed ever since he got his bad exam results. 

A. frustrated  B. delighted  C. nervous  D. stressed 

2. Many people who do volunteer work think they are more fortunate than others. 

A. lucky   B. blessed   C. uncomfortable D. unlucky  

3. Many people succeed in controlling their negative emotions. 

 A. pass B. fail C. develop D. resolve 

4. Although they hold similar political views, their religious beliefs present a striking contrast. 

 A. interesting resemblance B. complete coincidence 

 C. minor comparison  D. significant difference 

5. Mr. Smith’s new neighbors appear to be very nice. 

A. unfriendly   B. friendly   C. warm  D. kind-hearted 

6. Linh often volunteers to do presentations in front of the class. She’s a very confident student. 

A. responsible             B. friendly           C. shy                           D. sociable  

7. Watching the movie with all of my school friends was fun, but it was too lengthy. 

A. silly                        B. short                C. nice                          D. funny 

8. A calculating machine can do calculations with lightning speed. 

A. very slowly   B. incorrectly  C. very quickly D. perfectly 

9. Paying respect to people of seniority is a tradition in Viet Nam. 

A. bosses   B. old people  C. old-aged people D. young people 

READING 

Choose the correct answers to complete the passage. 

SPACE TOURISM 

Make your reservations now. The space tourism industry is (1) _______ open for business, and 

tickets are going for a mere $20 million for a one-week stay in space. Despite(2) _______ from 
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NASA, Russia made American businessman Dennis Tito the world’s first space tourist. Tito flew into 

space aboard a Russian Soyuz (3) _______ that arrived at the International Space Station (ISS) on 

April 30, 2001. The second space tourist, South African businessman Mark Shuttle worth, took (4) 

_______ aboard the Russian Soyuz on April 25,2002, also (5) _______ for the ISS. Greg Olsen, an 

American businessman, became tourist number three to the ISS on October 1, 2005. 

On September 18, 2006, Anousheh Ansari, a telecommunications entrepreneur, became the first 

female space tourist and the fourth space tourist (6) _______ . She was also the first person of Iranian 

descent to make (7) _______ into space. Charles Simonyi, a software architect, became the fifth space 

tourist on April 7,2007. 

These trips are the beginning of (8) _______ could be a lucrative 21st century industry. There are 

already several space tourism companies planning to build suborbital vehicles and orbital cities within 

the next two decades. These companies have (9) _______ millions, believing that the space tourism 

industry is on the (10) _______ of taking off. 

(From How Space Tourism Works, www.howstuffworks.com) 

 

1. a. immediately b. officially c. formally d. definitely 

2. a. acceptance b. reluctance c. insistence d. decision 

3. a. launcher b. satellite c. rocket d. missile 

4. a. in b. on c. over d. off 

5. a. head b. make c. direct d. bound 

6. a. thoroughly b. overall c. general d. together 

7. a. it b. her c. way d. sense 

8. a. when b. what c. which d. how 

9. a. invented b. raised c. invested d. paid 

10. a. verge b. border c. line d. strip 

WRITING 

Mark letter A, B, C or D on your answer sheet to indicate the sentence that is closest in meaning to 

the original sentence in each of the following questions. 

1. Study hard or you will fail the exam. 

A. You don’t fail the exam unless you study har    

B. If you don’t study hard, you will fail the exam. 

C. You don’t study hard, so you will fail the exam.   

D. Because you study hard, you don’t fail the exam.  

2. My school has no playground equipment or extra activities. 

A. I wish my school had had playground equipment or extra activities. 

B. I wish my school had playground equipment or extra activities. 

C. I wish my school can have playground equipment or extra activities. 

D. I wish my school will have playground equipment or extra activities. 

3. Although his leg was broken, he managed to get out of the car. 

A. In spite his broken leg, he managed to get out of the car. 

B. In spite of his broken leg, he managed to get out of the car. 

C. In spite his leg broken, he managed to get out of the car. 

D. In spite of his leg was broken, he managed to get out of the car. 

4. They reported that the troops were coming.  

A. It had been reported that the troops were coming. 

B. It was being reported that the troops were coming. 

C. It was reported that the troops to be coming. 

D. It was reported that the troops were coming. 
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5. “What time did you come home last night, Mark?” said Tom. 

A. Tom asked Mark what time had he come home the previous night. 

B. Tom asked Mark what time he had come home last night. 

C. Tom asked Mark what time he came home last night. 

D. Tom asked Mark what time he had come home the previous night. 

6. Did you always eat sweets when you were small? 

A. Were you use to eat sweets when you were small? 

B. Did you used to eat sweets when you were small? 

C. Were you used to eat sweets when you were small? 

D. Did you use to eat sweets when you were small? 

7. We last visited Ho Chi Minh city 3 years ago. 

A. We didn’t visit Ho Chi Minh city for 3 years. 

B. We haven’t visited Ho Chi Minh city for 3 years 

C. We haven’t visited Ho Chi Minh city for 3 years ago. 

D. We didn’t visit Ho Chi Minh city for 3 years go. 

8. I have not met her for three years.  

A. The last time I met her was three years ago.   

B. It is three years when I will meet her.  

C. I did not meet her three years ago.   

D. During three years, I met her once.  

9. We’ll get there early so that we’ll be able to get tickets. 

A. If we get there early, we’ll be able to get tickets. 

B. If we don’t get there early, we’ll be able to get tickets. 

C. If we get there early, we won’t be able to get tickets. 

D. Unless we get there early, we’ll be able to get tickets. 

10. “Close your books and go out to play”, the teacher said to us. 

A. The teacher told us close our books and go out to play. 

B. The teacher told us to closing our books and go out to play. 

C. The teacher told us closing our books and go out to play. 

D. The teacher told us to close our books and go out to play. 

11. My dad worked in a factory in the past, but doesn’t work there now. 

A. My dad used to working in a factory. 

B. My dad used to be working in a factory. 

C. My dad used to work in a factory. 

D. My dad used to be work in a factory. 

12. Mr. Peter has written a lot of articles for the CNN News. 

A. A lot of articles have written for the CNN News by Mr. Peter. 

B. A lot of articles have been written for the CNN News by Mr. Peter. 

C. A lot of articles has written for the CNN News by Mr. Peter. 

D. A lot of articles has been written for the CNN News by Mr. Peter. 

13. Although he was tired, he finished doing his homework. 

A. In spite his tiredness, he finished doing his homework. 

B. In spite of his tiredness, he finished doing his homework. 

C. In spite of he was tired, he finished doing his homework. 

D. In spite his tired, he finished doing his homework. 

14. They often went to school by bike when they were young. 

A. They used go to school by bike when they were young. 

B. They used to going to school by bike when they were young. 

C. They used to go to school by bike when they were young. 
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D. They used to went to school by bike when they were young. 

15. She has taught her children to play piano for 4 years. 

A. She started teaching her children to play piano 4 years ago. 

B. She started to teaching her children to play piano 4 years ago. 

C. She started teaching her children to play piano for 4 years ago. 

D. She started teaching her children to play piano since 4 years. 

16. It's a pity I can't cook as well as my mom. 

A. I wish I could cook as well as my mom. 

B. I wish I can cook as well as my mom. 

C. I wish I could cook as good as my mom. 

D. I wish I can cook as better as my mom. 

17. Shall we use environmental problem in Ha Noi as a theme of the presentation? 

A. She suggests use environmental problem in Ha Noi as a theme of the presentation. 

B. She suggests to use environmental problem in Ha Noi as a theme of the presentation. 

C. She suggests to using environmental problem in Ha Noi as a theme of the presentation. 

D. She suggests using environmental problem in Ha Noi as a theme of the presentation. 

18. Finish your homework or you can't go out with your friend.  

A. Unless you finish your homework, you can go out with your friend. 

B. If you don't finish your homework, you can go out with your friend. 

C. If you don't finish your homework, you can't go out with your friend. 

D. If you finish your homework, you can't go out with your friend. 

19. It took me 4 hours to read the first chapter of the book.  

A. I spent 4 hours reading the first chapter of the book. 

B. I spent 4 hours to read the first chapter of the book. 

C. I spent 4 hours to reading the first chapter of the book. 

D. I spent 4 hours read the first chapter of the book. 

20. Snowboarding is more dangerous than tennis. 

A. Tennis is as dangerous as snowboarding. 

B. Tennis is not as dangerous as snowboarding. 

C. Tennis is as dangerously as snowboarding. 

D. Tennis is not as dangerously as snowboarding. 

Mark the letter A, B, C, or D to indicate the sentence that is best written from the words/phrases given. 

21 I / strong / advise / you / take part/volunteer work 

A. I am strong advise that you should take part in volunteer work. 

B. I strongly advise that you might take part for volunteer work. 

C. I strongly advise that you should take part in volunteer work. 

D. I am strong in advising you to take part in volunteer work. 

22. what / often / do / Saturday / afternoon /? 

A. What often you do on Saturday afternoon? 

B. What do you often do on Saturday afternoon? 

C. What do you often do in Saturday afternoon? 

D. What did you often do on Saturday afternoon? 

23. I / sometimes come / see my friend / borrow/book 

A. I came sometimes to see my friend and borrow a book. 

B. I sometimes will come to see my friend and borrow a book. 

C. I sometimes come to see my friend and borrow a book. 

D. To see my friend sometimes I come to borrow a book. 

24. prefer / go to school / bike / walking 

A. I prefer to go to school by bike than walking. 
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A. I don't prefer going to school by bike but walking. 

C. I prefer to go to school by bike more than to walk. 

D. I prefer going to school by bike to walking. 

25. people / friendly / food / good 

A. The people are friendly and the food was good. 

B. The people were friendly and the food was good. 

C. The people were friendly but the food is good. 

D. The people was friendly and the food were good. 

26. not / forget / post / letter / give / you 

A. Don't forget posting the letter I gave to you. 

B. You don't forget to post the letter for you. 

C. Don't forget to post the letter I gave you. 

D. Don't forget and post the letter I gave you. 

27. Be quiet/listen / teacher/explanation 

A. Be quiet! We listen to the teacher explanation. 

B. Be quiet! We're listening to the teacher's explanation. 

C. Being quiet! We’re listening to the teacher's explanation. 

D. Being quiet! We always listen to the teacher's explanation. 

28. Duong/usually/his grandmother's house/Sunday. 

A. Duong usually goes to his grandmother' house on Sunday. 

B. Duong usually visits to his grandmother' house on Sunday. 

C. Duong usually looks at his grandmother' house on Sunday. 

D. Duong usually likes his grandmother' house on Sunday. 

29. not allow /photograph /interior /palace 

A. Taking photographs inside the palace is sometimes allowed. 

B. We are not allowing to photograph the interior of the palace. 

C. People are not allowed to make photographs in the palace interior. 

D. People are not allowed to photograph the interior of the palace. 

30. new school/build/our village 

A. A new school is usually built in our village. 

B. A new school has just been built in our village. 

C. The new school is building in our village. 

D. New school has just been built in our village. 

31. millions /people / watch /popular TV programme / every week 

A. Millions people watch the popularTV programme every week. 

B. Millions people watched that popularTV programme every week. 

C. Millions of people are watching popular TV programme every week. 

D. Millions of people watch this popular TV programme every week. 

32. my mum/not use/ wear/uniform / when /school 

A. My mum didn't use to wear uniform when she was at school. 

B. My mum wasn't used to wear uniform when she was at school. 

C. My mum didn't use to wearing uniform when she was at school. 

D. My mum isn't used to wearing uniform when she was at school. 

33. road/my house/flooded/due/heavy rain/last night 

A. The road in front of my house flooded due to the heavy rain last night. 

B. The road in front of my house was flooded due to the heavy rain last night. 

C. The road at my house is flooded due to the heavy rain at last night. 

D. The road in front of my house was flooded due the heavy rain last night. 
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34. Angkor Wat/ build /the 10th / 11th centuries 

A. Angkor Wat was built in the 10th and 11 th centuries. 

B. Angkor Wat is built in the 1 oth and 11 th centuries. 

C. Angkor Wat is built for the 1 oth and 11 th centuries. 

D. Angkor Wat was built from the 10th and 11 th centuries. 

35. Some students/volunteer/work/remote areas/provide education/children 

A. Some students are volunteering work in remote areas provide education for children. 

B. Some students volunteer working from remote areas to provide education for children. 

C. Some students volunteer working in remote areas to provide education with children. 

D. Some students volunteer to work in remote areas to provide education for children. 

PRACTICE TEST NO 1 

Mark the letter A, B, C or D on your answer sheet to indicate the word whose underlined part differs 

from the other three in pronunciation in each of the following questions.  

1. A. volcano   B. locate  C. oversleep  D. icon 

2. A. closed   B. looked  C. rained  D. followed 

Mark the letter A, B, C or D on your answer sheet to indicate the word that differs from the other 

three in the position of primary stress in each of the following questions.  

3. A. surface   B. remind  C. wander  D. spacecraft 

4. A. minority   B. expedition  C. technology  D. commitment 

Mark the letter A, B, C or D on your answer sheet to indicate the underlined part that needs 

correction in each of the following questions. 

5. U.K (United Kingdom) consists of two parts which are Great Britain and North Ireland.          

A. UK               B. consist of             C. which               D. are 

6. We’re really looking forward to taking to the zoo this Sunday by our parents.  

A. really looking  B. to taking  C. to the zoo  D. by our parents 

7. She studied enough hard, so she passed the exam easily.  

A. studied   B. enough hard C. so   D. easily 

Mark the letter A, B, C or D on your answer sheet to indicate the correct answer to each of the 

following questions. 

8. The story was __________that I couldn’t help laughing when I read it.  

A. too funny B. such funny C. very funny D. so funny 

10. There is………………water in the well but not enough for everyone in the village. 

A. few    B. a few  C. little  D. a little 

11. I bought these magazines_______have something to read on the trip. 

A. for    B. so that  C. so as to   D. in order 

12. I have been invited to a wedding ……………….. 14 February. 

A. in    B. of   C. on   D. at 

13. You don't seem very __________ about the party. Don't you want to go tonight? 

A. enthusiast   B. enthusiastic  C. enthusiasm  D. enthusiastically 

14. They will buy a new house when they get enough money, __________________? 

A. will they B. won’t they C. do they D. don’t they 

15. I wish Susan……………harder for her examination. 

A. will work   B. worked  C. has worked  D. works 

16. Mary was really__________by the beauty of Hanoi. 

A. impress   B. impression  C. impressed  D. impressive 

17. Would you mind if I……………your dictionary? 

A. borrow   B. am borrowing C. borrows  D. borrowed 

18. She __________a letter when the telephone rang. 

A. wrote   B. was writing  C. was written  D. has written 
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Mark the letter A, B, C or D on your answer sheet to indicate the most suitable response to complete 

each of the following exchanges.  

19. Jim: “What about collecting used paper, bottles and plastic bags every day?” - Ha and Mai: 

“_______” 

A. Because they can pollute the environment. B. How come? Who can do that? 

C. That's a very good idea. Let's do that.  D. What about this weekend? 

20. Phuong: “I'm taking my TOEFL test tomorrow.” - Daisy: “_______” 

A. Good fortune.   B. Good luck.   C. Good outcome.  D. Good success. 

Mark the letter A, B, C or D on your answer sheet to indicate the word CLOSEST in meaning to the 

underlined word in each of the following questions.  

21. I like playing sports like badminton. It is an exciting way to exercise.  

A. interesting B. regular C. normal D. boring 

22. Experiences at work help women to widen their knowledge.  

A. eliminate B. broaden C. restrict D. spoil 

Mark the letter A, B, C or D on your answer sheet to indicate the word(s) OPPOSITE in meaning to 

the underlined word(s) in each of the following questions. 

23. We can even learn foreign languages such as English, Russian on computers. 

A. known B. native  C. natural  D. expected 

24. Solar energy doesn't cause pollution, but it is not cheap. 

A. expensive   B. effective  C. commercial  D. possible 

Read the following passage and mark the letter A, B, C, or D on your answer sheet to indicate the 

correct word or phrase that best fits each of the numbered blanks. 

Since the world has become industrialized, there has been an increase in the number of animal 

species that have become extinct or nearly extinct. Bengal tigers, (25)……………..were once found in 

a large number in jungles, now are thought to be only 2,300 in number. By the year 2025 their (26) 

__________ in the world is estimated to be down to zero. The dangerous thing is that people don't hunt 

them for money but mainly (27) __________ they enjoy hunting them. Animals like the Bengal tiger, as 

well as other endangered species are very important to the world's ecosystem. International laws 

protecting these animals must be passed to save them. Countries around the world have begun to solve 

the problem in many ways. Reserves and national parks have been established. Money provided by world 

organizations has been spent on maintaining the parks. The use of products made from (28) _________ 

species has been stopped. 

25. A. whose   B. which   C. that     D. who 

26. A. population  B. amount   C. quantity    D. diversity 

27. A. for   B.therefore   C. because    D. so 

28. A.dangerous  B. danger   C. endangered   D. endanger 

Read the following passage and mark the letter A, B, C, or D on your answer sheet to indicate the 

correct answer to each of the questions.  

One of the biggest trends in television in recent years has been the rise of “Reality TV”. These 

shows, in which ordinary people are placed in unusual situations and then filmed without a script, have 

become some of the highest rating shows on television. Early programs of this genre, including Big 

Brother (from the Netherlands) and Survivor (from the United States), have led to dozens of copycat 

programs in many different countries. A common element to many of these programs is that a number 

of contestants are placed in a closed environment in which they are filmed 24 hours a day, and every 

week contestants are thrown off the show. What is it about these shows that makes them so popular? 

Perhaps it is because viewers enjoy watching ordinary people with real emotions being placed in 

extraordinary, situations. Or perhaps it is that people are really voyeurs - they enjoy being a spy, looking 

secretly into other people’s lives. 

29. In recent years, "Reality TV has become more and more_______. 

A. interesting   B. unusual   C. popular   D. enjoyable 

30. The underlined word ‘‘which” in the passage refers to_______. 
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A. a common element    B. a closed environment 

C. every week     D. the show 

31. What is true about “Reality TV”? 

A. They are made by ordinary people. B. They create many copycat programs. 

C. They describe people’s lives.  D. They are filmed without a script. 

32. We can infer from the passage that_______. 

A. “Reality TV” used to be more trendy 

B. “Reality TV" is becoming more and more competitive 

C. viewers enjoy watching something real but unusual 

D. viewers can become spies to look into other people’s lives 

Mark letter A, B, C or D on your answer sheet to indicate the sentence that is closest in meaning to 

the original sentence in each of the following questions. 

33. He started working in this company five years ago. 

A. He has worked in this company for five years. 

B. It was five years ago did he start working in this company. 

C. He hasn’t worked in this company for five years. 

D. It is five years since he has worked in this company. 

34. The woman was too weak to lift the basket. 

A. Although she was weak, she could lift the basket. 

B. The woman shouldn't have lifted the basket because she was so weak. 

C. She was so weak that she couldn't lift the basket. 

D. The woman lifted the basket, so she wasn't very weak. 

35. "If I were you, I would take a break," Tom said to Daisy. 

A. Tom wanted to take a break with Daisy. 

B. Tom advised Daisy to take a break. 

C. Tom suggested not taking a break. 

D. Tom wanted to take a break, and so did Daisy. 

36. Put on your coat or you will freeze to death in this weather.  

A. If you put on your coat, you will freeze to death in this weather.  

B. If you put on your coat, you would freeze to death in this weather.  

C. Unless you put on your coat, you would freeze to death in this weather.  

D. Unless you put on your coat, you will freeze to death in this weather. 

37. They did not let me in because I was not a member of the club. 

A. They invited me although I was not a member of the club. 

B. They did not allow me to enter because I was not a member of the club. 

C. They invited me to the clubs as if I had been a member. 

D. They asked me to get out of the club because I was not a member. 

38. The last time I went to the museum was four years ago. 

A. I have not been to the museum for four years. 

B. Four years ago, I often went to the museum. 

C. My going to the museum lasted four years. 

D. At last I went to the museum after four years 

39. They are not allowed to go out in the evening by their parents. 

A. Their parents do not want them to go out in the evening. 

B. Their parents never let them to go out in the evening. 

C. Going out in the evening is permitted by their parents. 

D. Although their parents do not allow, they still go out in the evening. 

40. This is the first time I attend such an exciting holiday. 

A. The first holiday I attended was exciting. 

B. I had the first exciting holiday. 

C. My attendance at the first holiday was exciting. 

D. I have never attended such an exciting holiday before. 
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PRACTICE TEST NO 2 

Mark the letter A, B, C or D on your answer sheet to indicate the word whose underlined part differs 

from the other three in pronunciation in each of the following questions. 

Question 1: A. garbage B. standard C. solar D. lunar 

Question 2: A. worked B. wanted C. stopped D. asked 

Mark the letter A, B, C or D on your answer sheet to indicate the word that differs from the other 

three in the position of primary stress in each of the following questions. 

Question 3: A. dancer B. cycling C. traffic D. balloon 

Question 4: A. develop     B. introduce               C. discover               D. continue    

Mark the letter A, B, C or D on your answer sheet to indicate the underlined part that needs 

correction in each of the following questions. 

Question 5: We can save nature resources by using solar energy. 

A. save  B. nature resources  C. using D. solar 

Question 6: Mr. Thanh, who sing English songs very well, is my teacher of English. 

A. who sing B. English songs  C. well  D. is 

Question 7: My father asked us not to spending too much timeplaying computer games. 

A. asked  B. not to spending  C. too much D. playing 

Mark the letter A, B, C or D on your answer sheet to indicate the correct answer to each of the 

following questions. 

Question 8: Do you mind if I turn _________the T.V? I want to watch the news. 

A. off     B. out   C. down  D. on 

Question 9: They are used _________outdoors and under pressure. 

A. to work   B. to be working C. to working  D. Worked 

Question 10: She asked me what _________. 

A. is my name  B. my name is  C. my name was D. my name 

Question 11: They have known each other _________they were children. 

A. to    B. for   C. while  D. Since 

Question 12: It’s very kind _________you to help me. 

A. to    B. of   C. with  D. for 

Question 13: If you eat too quickly, you may not _________attention to whether your hunger is satisfied. 

A. pay    B. take  C. keep  D. Show 

Question 14: If children don’t play sports, they _________sleepy and tired. 

A. would feel   B. will feel  C. would have felt D. had felt 

Question 15: Our plane arrives in Hanoi at _________ two o’clock in ______ afternoon. 

A. Ø - the               B. the - the       C. a - a            D. the - an 

Question 16: If he had driven more _________, he wouldn’t have had an accident. 

A. careful  B. careless  C. carefully  D. carelessly 

Mark the letter A, B, C or D to indicate the most suitable response to complete each of the following 

exchanges. 

Question 17: “Thank you very much for helping the disadvantaged children here!” 

-“__________”  

A. What a pity!  B. It’s our pleasure. 

C. Sorry, we don’t know  D. That’s nice of you. 

Question 18. - Jane: “Thank you very much for inviting me to your house!” 

     - Laura: “______. ” 

A. My pleasure is that B. That’s fine C. Take a seat D. It’s my pleasure 

 

Mark the letter A, B, C or D to indicate the word(s) OPPOSITE in meaning to the underlined word(s) 

in each of the following questions. 

Question 19. His rude comments made other Facebookers very angry. 
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A. pleasant  B. honest  C. polite  D. kind 

Question 20. We can even learn foreign languages such as English, Russian on computers. 

A. known B. native  C. natural  D. expected 

Mark the letter A, B, C or D to indicate the word(s) OPPOSITE in meaning to the underlined word(s) 

in each of the following questions. 

Question 21: Fresh water is very important to life because no one can live without it. Yes it is one of 

the limited and most endangered natural resources on our planet. 

A. Clean B. Drinkable C. Polluted D. Running 

Question 22: One way to protect our environment from pollution is to reduce wasteful consumption. 

A. costly B. excessive C. safe D. economical 

Read the following passage and mark the letter A, B, C, or D on your answer sheet to indicate the 

correct word or phrase that best fits each of the numbered blanks. 

 Since the world has become industrialized, there has been increase in the number of 

animal___(23)___ that have become extinct or nearly extinct. Bengal tigers,__(24)__ were once found 

in large number in jungles, now are thought to be only 2,300 in number. By the year 2025 their__(25)__ 

in the world is estimated to be down to zero. “The dangerous thing is that people don’t hunt them for 

money but mainly___(26)___ they enjoy hunting them. Animals like the Bengal tiger, as well as other 

endangered species are very important to the world’s ecosystem. International laws protecting these 

animal must be passed to save them. Countries around the world have begun to solve the problem in 

many ways. Reserves and national parks have been established. Money provided by world organizations 

has been spent on maintaining the parks. The use of products made them from___(27)__ species has 

been stopped. 

Question 23: A. kinds  B. types  C. families  D. species 

Question 24: A. whose  B. which  C. that   D. who 

Question 25: A. population  B. amount  C. quantity  D. diversity 

Question 26: A. for   B. therefore  C. because  D. so 

Question 27: A. dangerous  B. danger  C. endangered  D. endanger 

Read the following passage and mark the letter A, B or C on your answer sheet to indicate the 

correct answer to each of the questions. 

the correct answer to each of the questions. 

Up to now, there are still many people thinking films are things that are made to be shown on screen for 

entertainment. It is not right. There are many other kinds of film that are made for other purposes. For 

example, educational films are made for school. They are about the certain subjects that students are 

learning. Especially, when a person who learn a foreign language, educational films in the target 

language are very useful. Industry needs training films which introduce about machinery and equipment, 

and how to operate and work on them. Documentary films present factual events and circumstances of 

a social, political or historical nature. It is films that help us widen our knowledge of countries, cultures 

and people. Sitting on the arm chair in front of a TV set, a viewer can enjoy the beauty of nature all over 

the world, see many historic spots, and meet a lot of interesting people. A film, either good or bad, is the 

result of the collaboration of many individuals with many different specific skills and talents. And we, 

the viewers, should choose only suitable films to enjoy.  

26. According to the passage, all films are made ______.  

A. only for entertainment  B. to be shown in theaters 

C. to help students study foreign language D. for many purposes 

27. Educational films are made ______.  

A. for training manual workers  B. to enter students 

C. for teaching and learning  D. for schools and for industry 

28. Making a film ______.  

A. requires a lot of money and efforts                       B. involve the talents and skills of many people 

C. can take a lot of time                                     D. is a collaboration between filmmakers and 

viewers 
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29. Which of the following sentences is not mentioned in the passage? 

A. Not all films are made to be shown in theaters.  

B. You can learn a lot about other countries by seeing films 

C. Foreign films are essential for people who learn foreign language.  

D. The ending film should be happy.  

30. What does the word “they” in the passage refer to? 

A. people B. kinds of films C. purposes D. educational films 

Choose one sentence that has the same meaning as the root one. 

Question 33. He started learning French six years ago. 

A. He has learned French for six years.  

B. It was six years ago did he start learning French. 

C. He hasn’t learnt French for six years.  

D. It is six years since he has learnt French. 

Question 34. It was a two – hour flight from Hanoi to Ho Chi Minh city.  

A. It took two hours to fly from Hanoi to Ho Chi Minh city.  

B. It takes two hours to fly from Hanoi to Ho Chi Minh city.  

C. It took two hours flying from Hanoi to Ho Chi Minh city.  

D. It takes two hours flying from Hanoi to Ho Chi Minh city.  

Question 35. Peter enjoys playing football more than reading books.  

A. Peter doesn’t enjoy playing football as much as reading books.  

B. Peter enjoys reading books more than playing football.  

C. Peter doesn’t enjoy reading books as much as playing football.  

D. Peter enjoys playing football as much as reading books.  

Question 36. The last time I went to the museum was a year ago.  

A. I have not been to the museum for a year.  

B. A year ago, I often went to the museum.  

C. My going to the museum lasted a year.   

D. At last I went to the museum after a year 

Mark the letter A, B, C, or D on your answer sheet to indicate the sentence that best combines each 

pair of sentences in the following questions. 

Question 37: The woman was very weak. She couldn’t lift the basket.  

A. Although she was weak, she could lift the basket.  

B. The woman shouldn't have lifted the basket because she was so weak.  

C. She was too weak to lift the basket.  

D. The woman lifted the basket, so she wasn't very weak.  

Question 38: They did not let me in. I was not a member of the club. 

 A. They invited me although I was not a member of the club.  

 B. They did not allow me to enter because I was not a member of the club.  

 C. They invited me to the clubs as if I had been a member.  

 D. They asked me to get out of the club because I was not a member.  

Question 39. Because Jane was sick, she couldn't come to class.  

A. Because of Jane's sickness, she couldn't come to class.  

B. In spite of Jane's sickness, she couldn't come to class.  

C. But for Jane's sickness, she could come to class.  

D. Due to Jane's sickness, she could come to class.  

Question 40: The coffee was not strong. It didn’t keep us awake. 

A. The coffee was very strong, but it couldn’t keep us awake. 

B. We were kept awake because the coffee was strong. 

C. The coffee was not strong enough to keep us awake.  

D. The coffee was so hot that it didn’t keep us awake. 
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MÔN VẬT LÝ    
I/ LÝ THUYẾT :  
 

1. Dòng điện xoay chiều là gì ? Trình bày các cách tạo ra dòng điện xoay chiều ?  

2. Viết công thức tính điện năng hao phí trên đường dây tải điện? Nêu các cách làm giảm hao 

phí điện khi truyền tải điện năng đi xa?  

3. Nêu cấu tạo và nguyên tắc hoạt động của máy biến thế? Viết công thức máy biến thế. 

4. Hiện tượng khúc xạ ánh sáng là gì ? Phân biệt hiện tượng khúc xạ và hiện tượng phản xạ ánh 

sáng  ? 

5. Thấu kính hội tụ:  

- Nêu đặc điểm của thấu kính hội tụ và đường đi của các tia sáng đặc biệt qua thấu kính ?  

- Vẽ và trình bày cách vẽ ảnh thật (d>f) và vẽ ảnh ảo (d<f)  của vật sáng qua thấu kính hội tụ. 

Trình bày rõ 3 đặc điểm của ảnh trong từng trường hợp. 

6. Thấu kính phân kì: 

- Nêu đặc điểm của thấu kính phân kì và đường đi của các tia sáng đặc biệt qua thấu kính thấu 

kính phân kì ?  

- Vẽ và trình bày cách vẽ ảnh của vật sáng qua thấu kính phân kì. Trình bày rõ 3 đặc điểm của 

ảnh trong từng trường hợp. 

 

II/ BÀI TẬP TRẮC NGHIỆM :  

Câu 1: Một con cá vàng  đang bơi trong bể cá cảnh có thành bằng thủy tinh trong suốt. Một 

người  ngắm con cá qua thành bể. Hỏi tia sáng truyền từ con cá đến mắt người đã chịu bao 

nhiêu lần khúc xạ? 

 A. Không lần nào. B. Một lần. C. Hai lần. D. Ba lần. 

Câu 2: Biểu thức xác định công suất hao phí trên đường dây tải điện là: 

 A. Php= 
 𝑃2

𝑅
𝑈2 B. Php= 

 𝑃2

𝑈2 . 𝑅 C. Php= 
1

𝑅
𝑃𝑈2 D. Php= 𝑅

 𝐼2 

𝑈2.  

Câu 3: Tăng hiệu điện thế hai đầu dây đãn lên 100 lần thì công suất hao phí vì tỏa nhiệt sẽ: 

 A. Tăng lên 200 lần. B. Tăng lên 100 lần. 

 C. Giảm 10000 lần. D. Giảm đi 100 lần. 

Câu 4: Các tác dụng của dòng điện xoay chiều là: 

 A. Tác dụng nhiệt, hóa học và từ. B. Tác dụng nhiệt, quang và từ. 

 C. Tác dụng nhiệt, quang và hóa học. D. Tác dụng quang, từ và hóa học. 

Câu 5: Vật liệu nào không được dùng làm thấu kính 

 A. Thuỷ tinh trong. B. Nhựa trong. 

 C. Nhôm. D. Nước 

Câu 6: Thấu kính phân kì là loại thấu kính 

 A. có phần rìa dày hơn phần giữa. 

 B. có phần rìa mỏng hơn phần giữa. 

 C. biến đổi chùm tia tới song song thành chùm tia ló hội tụ. 

 D. có thể làm bằng chất rắn không trong suốt. 

Câu 7: Khoảng cách giữa hai tiêu điểm của thấu kính phân kì bằng 

 A. tiêu cự của thấu kính. B. hai lần tiêu cự của thấu kính. 

 C. bốn lần tiêu cự của thấu kính. D. một nửa tiêu cự của thấu kính. 
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Câu 8: Dòng điện xoay chiều có cường độ và hiệu điện thế luôn thay đổi theo thời gian. Vậy 

ampe kế xoay chiều chỉ giá trị nào của cường độ dòng điện xoay chiều ? 

 A. Giá trị cực đại. B. Giá trị cực tiểu. 

 C. Giá trị trung bình. D. Giá trị hiệu dụng. 

Câu 9: Hiện tượng khúc xạ ánh sáng là hiện tượng tia sáng tới khi gặp mặt phân cách giữa hai 

môi trường 

 A. Bị hắt trở lại môi trường cũ. 

 B. Tiếp tục đi thẳng vào môi trường trong suốt thứ hai. 

 C. Tiếp tục đi song song với mặt phân cách giữa hai môi trường. 

 D. Bị gãy khúc tại mặt phân cách giữa hai môi trường và tiếp tục đi vào môi trường trong 

suốt thứ hai. 

Câu 10: Chiếu một tia sáng vuông góc với bề mặt thủy tinh. Khi đó góc khúc xạ bằng 

 A. 600 B. 900. C. 00. D. 300. 

Câu 11: Cuộn sơ cấp của máy biến thế có 200 vòng, cuộn thứ cấp 50 vòng, khi đặt vào hai đầu 

cuộn sơ cấp một hiệu điện thế xoay chiều 6V thì ở hai đầu cuộn thứ cấp có hiệu điện thế là: 

 A. 1,5V B. 4,5V C. 9V D. 3V 

Câu 12: Trong hiện tượng khúc xạ ánh sáng, góc khúc xạ (r) là góc tạo bởi 

 A. tia khúc xạ và mặt phân cách. B. tia khúc xạ và điểm tới. 

 C. tia khúc xạ và tia tới. D. tia khúc xạ và pháp tuyến tại điểm tới. 

Câu 13: Thiết bị nào sau đây có thể họat động tốt đối với dòng điện một chiều lẫn xoay chiều? 

 A. Đèn điện B. Máy sấy tóc 

 C. Tủ lạnh D. Đồng hồ treo tường chạy bằng pin 

Câu 14: Một đồng tiền xu được đặt ở đáy một cái cốc. Khi chưa có nước vào cốc thì không 

thấy đồng xu, nhưng khi cho nước vào lại trông thấy đồng xu vì: 

 A. có sự truyền thẳng ánh sáng. B. có sự phản xạ ánh sáng. 

 C. có sự phản xạ tòan phần. D. có sự khúc xạ ánh sáng. 

Câu 15: Phương pháp nào sau đây có thể làm giảm hao phí trên đường dây tải điện? 

 A. Tăng hiệu điện thế đặt vào hai đầu dây. 

 B. Tăng điện trở dây đẫn của dây tải. 

 C. Tăng chiều dài dây tải điện. 

 D. Tăng cường độ dòng điện chạy qua dây tải. 

Câu 16: Trên cùng đường dây tải đi cùng một suất điện, nếu đường dây tải điện dài gấp đôi thì 

công suất hao phí vì tỏa nhiệt sẽ: 

 A. Giảm 2 lần. B. Tăng 4 lần. 

 C. Không tăng, không giảm. D. Tăng 2 lần. 

Câu 17: Máy biến thế có tác dụng gì? 

 A. Giảm công suất truyền tải. 

 B. Biến đổi hiệu điện thế hai đầu dây dẫn điện. 

 C. Giảm điện trở của dây dẫn. 

 D. Giảm công suất của nguồn điện. 

Câu 18: Nhận xét nào sau đây là đúng về ảnh của vật tạo bởi thấu kính hội tụ? 

 A. Vật đặt trong khoảng tiêu cự cho ảnh thật cùng chiều vật 

 B. Vật đặt trong khoảng tiêu cự cho ảnh ảo ngược chiều vật 

 C. Vật đặt ngoài khoảng tiêu cự cho ảnh thật ngược chiều vật 

 D. Vật đặt ngoài tiêu cự cho ảnh ảo cùng chiều vật 
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Câu 19: Tia tới song song với trục chính của thấu kính hội tụ cho tia ló 

 A. song song với trục chính. 

 B. đi qua điểm giữa quang tâm và tiêu điểm 

 C. truyền thẳng theo phương của tia tới. 

 D. đi qua tiêu điểm. 

Câu 20: Một tia sáng khi truyền từ nước ra không khí thì: 

 A. Góc khúc xạ lớn hơn góc tới. 

 B. Góc khúc xạ nằm trong môi trường nước. 

 C. Tia khúc xạ hợp với pháp tuyến một góc 300. 

 D. Góc khúc xạ nhỏ hơn góc tới. 

Câu 21: Chiếu chùm tia sáng song song với trục chính của thấu kính hột tụ thì: 

 A. Chùm tia ló là chùm hội tụ tại tiêu điểm của thấu kính 

 B. Chùm tia ló cũng là chùm song song. 

 C. Chùm tia ló là chùm tia bất kì 

 D. Chùm tia ló là chùm phân kì 

Câu 22: Tia tới song song với trục chính của thấu kính phân kỳ cho tia ló 

 A. đi qua tiêu điểm của thấu kính. 

 B. có đường kéo dài đi qua tiêu điểm của thấu kính. 

 C. cắt trục chính của thấu kính tại một điểm bất kì. 

 D. song song với trục chính của thấu kính. 

Câu 23: Phát biểu nào sau đây là đúng khi nói về nguyên tắc hoạt động của máy phát điện 

xoay chiều ? 

 A. Máy phát điện xoay chiều hoạt động dựa trên tác dụng cơ học của dòng điện. 

 B. Máy phát điện xoay chiều hoạt động dựa trên hiện tượng cảm ứng điện từ. 

 C. Máy phát điện xoay chiều hoạt động dựa trên tác dụng nhiệt của dòng điện. 

 D. Máy phát điện xoay chiều hoạt động dựa trên tác dụng hóa học của dòng điện. 

Câu 24: Tia tới đi qua tiêu điểm của thấu kính hội tụ cho tia ló 

 A. truyền thẳng theo phương của tia tới.  

 B. đi qua điểm giữa quang tâm và tiêu điểm. 

 C. song song với trục chính. 

 D. có đường kéo dài đi qua tiêu điểm. 

 

II/ BÀI TẬP TỰ LUẬN :  

    Bài 1: Cuộn sơ cấp của một máy biến thế có 1000 vòng, cuộn thứ cấp có 5000 vòng đặt ở một 

đầu đường dây tải điện để truyền đi một công suất điện là 10 000kW. Biết hiệu điện thế ở hai 

đầu cuộn thứ cấp là 100kV.  

a. Tính hiệu điện thế đặt vào hai đầu cuộn sơ cấp ? 

b. Biết điện trở của toàn bộ đường dây là 100. Tính công suất hao phí do tỏa nhiệt trên 

đường dây? 

Bài 2:  Hình bên cho biết:  là trục chính của một thấu kính,                                              C            

           CD là ảnh ảo của vật AB tạo bởi thấu                                                               B             

           kính đó. Đó là thấu kính  gì ? Vì sao?                                           

 Hãy trình bày cách vẽ để xác định quang tâm O,   A D 

           hai tiêu điểm F và F' của thấu kính.    
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Bài 3. Đặt vật sáng MN vuông góc với trục chính của 1 thấu kính hội tụ. Thấu kính có tiêu cự 

15cm, vật cao 3cm. Vẽ và nhận xét về ảnh và tính khoảng cách từ ảnh tới thấu kính, chiều 

cao của ảnh trong các trường hợp sau: 

a) Vật đặt cách thấu kính 10 cm 

b) Vật đặt cách thấu kính 20 cm 

c) Vật đặt cách thấu kính 30 cm 

d) Vật đặt cách thấu kính 40 cm                                                                             

Bài 4. Đặt vật AB vuông góc với thấu kính phân kì sao cho A nằm trên trục chính và cách thấu  

          kính 30cm thì ảnh cách thấu kính 18cm. 

a) Tính tiêu cự của thấu kính. 

          b)  Biết AB = 4,5cm. Tìm chiều cao của ảnh. 
 

Xem và làm lại các bài tập trong sách bài tập. 

 

 

MÔN HÓA HỌC 

 

I. LÝ THUYẾT:  

1. Ôn tập về các oxit của cacbon và muối cacbonat 

2. Cấu tạo bảng tuần hoàn (Ô nguyên tố, chu kì, nhóm). 

3. Sự biến đổi tính chất của các nguyên tố trong bảng tuần hoàn (Trong một chu kì, 

trong một nhóm). 

4. Khái niệm về hợp chất hữu cơ, hóa học hữu cơ. 

5. Cấu tạo phân tử hợp chất hữu cơ. 

6. Trạng thái, cấu tạo, tính chất và ứng dụng của Metan. 

7. Trạng thái, cấu tạo, tính chất và ứng dụng của Etilen. 

8. Trạng thái, cấu tạo, tính chất và ứng dụng của Axetilen. 

II. BÀI TẬP THAM KHẢO 

Câu 1: Cho 21 gam  MgCO3 tác dụng với một  lượng vừa đủ dung dịch HCl 2M. Thể 

tích dung dịch HCl đã dùng là  

A. 0,50 lít.  B. 0,25 lít.   C. 0,75 lít.  D. 0,15 lít. 

Câu 2: Đốt cháy hoàn toàn 1,2 gam C thì thể tích tối đa của khí CO2 thu được ở đktc là  

A. 1,12 lít.  B. 11,2 lít.   C. 2,24 lít.  D. 22,4 lít. 

Câu 3: Khử hoàn toàn 48 gam  đồng (II) oxit bằng khí CO. Thể tích khí CO cần dùng 

(đktc) là  

A. 13,44 lít.  B. 11,2 lít.   C. 6,72 lít.  D. 44,8 lít. 

Câu 4: Cho 2,24 lít CO2 (đktc) tác dụng với 200 ml dung dịch Ca(OH)2 chỉ tạo muối 

trung hòa. CM của dung dịch Ca(OH)2 đã dùng là  

A. 0,55 M.  B. 0,45 M.   C. 0,5 M.  D. 0,65 M. 

Câu 5: Để nhận biết 2 lọ mất nhãn đựng CH4  và C2H4 ta dùng :  

A. DD nước brom    B. Que đóm còn tàn đỏ   C. Quỳ tím  D. dd Ca(OH)2 

Câu 6: Để nhận biết 2 lọ mất nhãn đựng CH4  và C2H2 ta dùng :  

A. DD KOH  B. Que đóm còn tàn đỏ    C. Quỳ tím ẩm         D. dd nước brom 
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Câu 7: Đốt cháy hoàn toàn 14 gam khí etilen. Thể tích khí oxi cần dùng ở đktc và khối 

lượng khí CO2 sinh ra là 

A. 33,6 lít; 44 gam. B. 22,4 lít; 33 gam. C. 5,6 lít; 11 gam. D. 11,2 lít; 22 gam. 

Câu 8: Thể tích không khí (chứa 20% thể tích oxi) đo ở đktc cần dùng để đốt cháy hết 

3,2 gam khí metan là  

A. 22,4 lít. B. 44,8 lít. C. 17,92 lít. D. 8,96 lít. 

Câu 9: Khối lượng khí etilen cần dùng để phản ứng hết 8 gam brom trong dung dịch là 

A. 1,4 gam. B. 0,7 gam. C. 14 gam. D. 7 gam. 

Câu 10: Đốt cháy hoàn toàn 1 mol khí axetilen thì cần bao nhiêu lít không khí (các khí 

đo ở đktc, biết rằng oxi chiếm 20% thể tích không khí) ? 

A. 240 lít. B. 280 lít. C. 300 lít. D. 120 lít. 

Câu 11: Khí X có thành phần phần trăm về khối lượng nguyên tố cacbon trong hợp chất 

là 85,7 %. Khí X là 

A. C2H5Cl. B. CH4. C. C2H4. D. CH3Cl. 

Câu 12: Một hợp chất hữu cơ A có thành phần phần trăm khối lượng cacbon là 75%. 

Vậy A là 

A. C2H2. B. C2H4. C. C2H6. D. CH4. 

Câu 13: 2,9 gam chất A ở đktc có thể tích là 1,12 lít. Vậy A là 

A. C4H10. B. CH4. C. C3H8. D. C4H8. 

Câu 14: Khí X có tỉ khối đối với oxi là 0,8125. Khí X là 

A. CH4. B. C2H6. C. C2H4 . D. C2H2. 

Câu 15: Tỉ khối hơi của khí A đối với CH4 là 1,75 thì khối lượng phân tử của A là  

A. 20 đvC.  B. 24 đvC.  C. 29 đvC.   D. 28 đvC. 

 

 

MÔN SINH HỌC  

 

1. Ứng dụng di truyền học 

- Giao phối gần là gì? Nêu những hậu quả xảy ra ở động vật, thực vật. 

- Nêu khái niệm ưu thế lai. Nêu ví dụ ưu thế lai ở động vật và thực vật. 

- Nêu nguyên nhân của hiện tượng ưu thế lai. 

2.  Sinh vật và môi trường 

- Nhân tố sinh thái là gì? Phân loại các nhân tố sinh thái. 

- Ánh sáng ảnh hưởng như thế nào lên đời sống của thực vật và động vật? 

- Nhiệt độ ảnh hưởng như thế nào tới đặc điểm hình thái, sinh lí của sinh vật? 

- Thế nào là động vật biến nhiệt và động vật hằng nhiệt? Lấy ví dụ. 

3.  Hệ sinh thái 

- Quần thể sinh vật là gì? Nêu ví dụ. 

- Nêu các yếu tố môi trường ảnh hưởng tới quần thể sinh vật. 
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MÔN LỊCH SỬ 

 

I. NỘI DUNG ÔN TẬP 

Lịch sử Việt Nam từ năm 1919 đến cách mạng tháng Tám năm 1945. 

Bài 21. Việt Nam trong những năm 1939 - 1945. 

Bài 22. Cao trào cách mạng tiến tới Tổng khởi nghĩa tháng Tám 1945. 

Bài 23. Tổng khởi nghĩa tháng Tám năm 1945 và sự thành lập nước Việt Nam dân chủ 

cộng hoà. 

II. HÌNH THỨC KIỂM TRA:  100% Trắc nghiệm khách quan  

III. CÂU HỎI MINH HOẠ: 

Câu 1: Sự kiện nào trên thế giới có tác động sâu sắc nhất tới tình hình Việt Nam giai 

đoạn 1939-1945? 

A. Nhật và Pháp ký “Hiệp ước phòng thủ chung Đông Dương”. 

B. Trục phát xít được hình thành. 

C. Chiến tranh thế giới thứ II diễn ra. 

D. Pháp đầu hàng phát xít Đức. 

Câu 2: Khởi nghĩa Nam Kỳ nổ ra năm bao nhiêu? 

A. 1942. B. 1940. C. 1941. D. 1939. 

Câu 3: Thực dân Pháp ở Đông Dương thẳng tay đàn áp phong trào cách mạng Đông 

Dương và thỏa hiệp với phát xít Nhật, phát xít Nhật lôi kéo tập hợp tay sai tuyên truyền 

lừa bịp để dọn đường hất cẳng Pháp. Đó là đặc điểm tình hình Việt Nam trong thời kỳ 

A. 1939-1945 B. 1932-1933 C. 1930-1931 D. 1936-1939 

Câu 4: Nguyên nhân chung làm cho ba cuộc khởi nghĩa Bắc Sơn, Nam Kì và binh biến 

Đô Lương thất bại là gì? 

A. Quần chúng chưa sẵn sàng. 

B. Kẻ thù còn mạnh, lực lượng cách mạng chưa được tổ chức, chuẩn bị đầy đủ, thời 

cơ chưa chín muồi. 

C. Lực lượng vũ trang còn yếu. 

D. Lệnh tạm hoãn khởi nghĩa về không kịp. 

Câu 5: Lần đầu tiên lả cờ đỏ sao vàng xuất hiện trong cuộc khởi nghĩa nào? 

A. Cuộc khởi nghĩa Bắc Sơn (9/1940). B. Cuộc binh biến Đô Lương (1/1941). 

C. Cuộc khởi nghĩa Nam Kì (11/1940). D. Cả ba cuộc khởi nghĩa trên. 

Câu 6: Những người con ưu tú của Đảng như: Nguyễn Văn Cừ, Hà Huy Tập, Nguyễn 

Thị Minh Khai bị thực dân Pháp xử bắn sau cuộc khởi nghĩa nào? 

A. Binh biến Đô Lương (1/1941). B. Khởi nghĩa Nam Kì (11/1940). 

C. Khởi nghĩa Bắc Sơn (9/1940). D. Khởi nghĩa Yên Bái (2/1930). 
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MÔN ĐỊA LÝ 

 

I. Vùng Đông Nam Bộ  

Câu 1. Điều kiện tự nhiên và tài nguyên thiên nhiên ảnh hưởng như thế nào đến sự 

phát triển của vùng Đông Nam Bộ? 

Câu 2. Điều kiện để phát triển ngành nông nghiệp và tình hình phát triển ngành 

nông nghiệp của vùng Đông Nam Bộ? 

Câu 3. Điều kiện để phát triển ngành công nghiệp và tình hình phát triển ngành 

công nghiệp của vùng Đông Nam Bộ? 

II. Vùng Đồng bằng sông Cửu Long 

Câu 1. Vị trí địa lí và giới hạn lãnh thổ, điều kiện tự nhiên và tài nguyên thiên 

nhiên (thuận lợi, khó khăn, biện pháp). 

Câu 2. Tình hình phát triển kinh tế (nông nghiệp, công nghiệp, dịch vụ) 

III. Câu hỏi trắc nghiệm tham khảo 

Câu 1. Đông Nam Bộ tiếp giáp với vùng nào sau đây? 

A. Bắc Trung Bộ.                                    B. Trung du miền núi Bắc Bộ 

C. Đồng bằng sông Hồng                                  D. Đồng bằng Sông Cửu Long. 

Câu 2. Căn cứ vào Atlat Địa lí Việt Nam trang 29, cho biết tỉnh, thành phố nào sau đây 

không thuộc vùng Đông Nam Bộ? 

A. Bình Dương.         B. TP. Hồ Chí Minh.       C. An Giang      D. Tây Ninh. 

Câu 3. Căn cứ vào Atlat Địa lí Việt Nam trang 19, hãy cho biết cây công nghiệp lâu năm 

nào chiếm diện tích lớn nhất ở Đông Nam Bộ?  

A. Cao su                B. Cà phê                          C. Hồ tiêu            D.  Điều 

Câu 4. Khó khăn lớn nhất của Đông Nam Bộ đối với phát triển kinh tế là:  

A. chỉ có hai tỉnh và thành phố tiếp giáp biển.  

B. đất đai kém màu mỡ và thời tiết thất thường.  

C. ít khoáng sản, rừng; nguy cơ ô nhiễm môi trường. 

D. tài nguyên sinh vật hạn chế, nguy cơ suy thoái. 

Câu 5. Căn cứ vào Atlat Địa lí Vìệt Nam trang 10, cho biết hồ thủy lợi nào sau đây thuộc 

Đông Nam Bộ?  

A. Hồ Ba Bể         B. Hồ Dầu Tiếng      C. Hồ Đa Nhim     D. Hồ Thác Bà 

Câu 6. Trung tâm công nghiệp nào sau đây của Đông Nam Bộ là trung tâm công nghỉệp 

khai thác dầu khí?  

A. Biên Hòa    B. TP Hồ Chí Minh       C. Thủ Dầu Một    D. Bà Rịa - Vũng Tàu 

Câu 7. Căn cứ vào Atlat Địa lí Việt Nam trang 21, hãy cho biết trung tâm công nghiệp 

nào sau đây có quy mô lớn nhất Đông Nam Bộ?  

A. Thủ Dầu Một        B. TP Hồ Chí Minh         C. Biên Hòa          D. Vũng Tàu  

Câu 8. Vấn đề quan trọng hàng đầu trong việc đẩy mạnh thâm canh cây trồng ở Đông 

Nam Bộ là gì? 

A. Thủy lợi.    B. Phân bón.  C. Bảo vệ rừng đầu nguồn.   D. Phòng chống sâu bệnh. 
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Câu 9. Ý nào sau đây không phải ảnh hưởng của vị trí địa lí đối với Đồng bằng sông Cửu 

Long?  

A. Có mối quan hệ chặt chẽ với vùng Đông Nam Bộ.  

B. Thuận lợi giao lưu với các nước tiểu vùng sông Mê Công.  

C. Thuận lợi giao lưu, trao đổi kinh tế xã hội với vùng Tây Nguyên.  

D. Phát triển tổng hợp kinh tế biển. 

Câu 10. Đồng bằng sông Cửu Long là đồng bằng châu thổ được bồi đắp bởi phù sa của 

hệ thống sông nào? 

A. Sông Hồng và sông Thái Bình      B. Sông Tiền và sông Hậu 

C. Sông Sài Gòn và sông Bé              D. Sông Vàm Cỏ Đông và sông Vàm Cỏ Tây 

Câu 11. Đặc điểm nào sau đây không đúng với Đồng bằng sông Cửu Long?  

A. Rộng khoảng 40 nghìn km², địa hình cao và phẳng hơn đồng bằng sông Hồng. 

B. Không có đê, mạng lưới kênh rạch chằng chịt.  

C. Mùa lũ, nước ngập trên diện rộng. Mùa cạn, thủy triều lấn mạnh làm gần 2/3 

diện tích đồng bằng bị nhiễm mặn.  

D. Có các vùng trũng lớn như Đồng Tháp Mười, Tứ giác Long Xuyên.  

Câu 12. Nhóm đất nào sau đây có diện tích lớn nhất ở Đồng bằng sông Cửu Long? 

A. Đất cát ven biển        B. Đất phèn            C. Đất mặn         D. Đất phù sa ngọt 

Câu 13. Các dân tộc ít người sinh sống ở Đồng bằng sông Cửu Long là: 

A. Khơ me, Chăm, Hoa   B. Tày, Dao, Mông    C. Tày, Nùng, Thái     D. Gia Rai, Ê Đê 

Câu 14. Các sản phẩm nông nghiệp nào sau đây được xem là thế mạnh của ĐB sông Cửu Long? 

A. Cao su, cam, quýt                                           B. Ca cao, cà phê, dừa 

C. Lúa, cam, bưởi, tôm, cá                                  D. Lúa, cà phê, tôm, cá 

Câu 15. Trong cơ cấu giá trị sản xuất công nghiệp ở Đồng bằng sông Cửu Long, ngành 

nào sau đây chiếm tỉ trọng lớn nhất? 

A. Công nghiệp cơ khí.                                          C. Sản xuất vât liệu xây dựng. 

 B. Chế biến lương thực thực phẩm.                       D. Sản xuất hàng tiêu dùng. 

 

 

MÔN GIÁO DỤC CÔNG DÂN 

                   

I. PHẠM VI ÔN TẬP 

Bài 12: Quyền và nghĩa vụ của công dân trong hôn nhân 

Bài 13: Quyền tự do kinh doanh và nghĩa vụ đóng thuế  

Bài 14: Quyền và nghĩa vụ lao động của công dân 

II. CÂU HỎI MINH HỌA  

Câu 1: Hôn nhân là gì? Nguyên tắc của chế độ hôn nhân hiện nay?                       

Câu 2: Luật Hôn nhân và gia đình Việt Nam hiện nay quy định những trường hợp nào 

được kết hôn & cấm kết hôn? 

Câu 3: Khái niệm kinh doanh và quyền tự do kinh doanh là gì?  

Câu 4: Khi kinh doanh công dân cần phải tuân thủ điều gì?  

Câu 5: Em hiểu thế nào là quyền và nghĩa vụ lao động của công dân? 
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Câu 6: Cho bảng số liệu sau: 

Mặt hàng Mức thuế Mặt hàng Mức thuế 

Thuốc lá điếu 65% Nước sạch, đồ dùng dạy học 5% 

Xăng 10% Rượu dưới 20 độ 25% 

Hàng mã, vàng mã 70% Khẩu trang, dung dịch sát khuẩn… Miễn thuế 

Giống vật nuôi cây trồng Miễn thuế   

 Em có nhận xét gì về mức thuế của các mặt hàng trên? Vì sao có sự chênh lệch đó? 

Câu 7: Thuế là gì? Bằng hiểu biết của mình hãy phân tích tác dụng của thuế? 

Câu 8: Tìm hiểu quy định của pháp luật về lao động chưa thành niên ( tuổi lao động, thời gian 

lao động…) 

Câu 9: Hôn nhân là sự liên kết đặc biệt giữa………………trên nguyên tắc bình đẳng, tự nguyện 

được …….. ……………….thừa nhận nhằm chung sống lâu dài và xây dựng một gia đình hạnh 

phúc. 

A. hai người yêu nhau - pháp luật                                    

B. một nam và một nữ - gia đình 

C. một nam và một nữ - nhà nước                                    

D. hai người yêu nhau - gia đình 

Câu 10: Kinh doanh là 

A. hoạt động sản xuất vật chất, dịch vụ và trao đổi hàng hóa nhằm thu lợi nhuận 

B. là quyền của công dân được lựa chọn hình thức tổ chức kinh tế 

C. là quyền của công dân được tự do lựa chọn ngành nghề và quy mô kinh doanh 

D. là nghĩa vụ và trách nhiệm của mỗi công dân 

Câu 11: Điều nào sau đây không đúng với trách nhiệm của công dân trong hôn nhân? 

A. Có thái độ thận trọng và nghiêm túc trong tình yêu 

B. Có thái độ thận trọng trong hôn nhân 

C. Không vi phạm quy định của pháp luật về hôn nhân 

D. Là chuyện riêng của mỗi người nên người khác không có quyền can thiệp. 

Câu 12:  Khi kết hôn pháp luật cấm điều nào dưới đây? 

A. Kết hôn trong phạm vi đời thứ 4.                          

B. Dựa trên tình yêu chân chính. 

C. Nam từ 18 tuổi, nữ từ 20 tuổi trở lên.                    

D. Hôn nhân đồng giới. 

Câu 13: Đáp án nào sau đây không chỉ những người có họ trong phạm vi ba đời? 

A. Không có quan hệ họ hàng.                                         

B.  Anh chị em cùng cha khác mẹ. 

C. Anh em con chú con bác.                                             

D. Anh chị em cùng cha mẹ. 

Câu 14: Đáp án nào sau đây không đúng về những người cùng dòng máu trực hệ? 

A. Cha mẹ đối với con.                                                    

B.  Ông bà nội đối với cháu nội. 

C. Ông bà ngoại với cháu ngoại.                                      

D. Anh chị em cùng cha mẹ. 

Câu 15: Quyền tự do kinh doanh là                                                                                                                    

A. hoạt động sản xuất vật chất, dịch vụ và trao đổi hàng hóa nhằm thu lợi nhuận                                             

B. là quyền cơ bản của công dân 
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C. là nghĩa vụ và trách nhiệm của mỗi công dân 

D. là quyền của công dân được lựa chọn hình thức tổ chức kinh tế, ngành nghề và quy 

mô kinh doanh 

Câu 16: Biểu hiện nào sau đây không đúng về vai trò của thuế?                                                                               

A.Thuế dùng để điều chỉnh cơ cấu kinh tế cho hợp lí. 

B.Thuế dùng để ổn định thị trường. 

C.Thuế dùng để xây dựng trường học, bệnh viện, đường xá…                                                                         

D.Thuế chỉ dùng để đầu tư phát triển quân sự, quốc phòng an ninh 

Câu 17: “mọi người có nghĩa vụ lao động để tự nuôi sống bản thân, nuôi sống gia đình, góp 

phần duy trì và phát triển đất nước” thuộc khái niệm nào dưới đây? 

A. Lao động.                        

B. Quyền lao động. 

C. Nghĩa vụ lao động.              

D. Hợp đồng lao động. 

Câu 18: Trong Phần Đặt vấn đề bài 14: Quyền và nghĩa vụ lao động của công dân, có phần 

viết về ông An. Theo em ông An là người: 

A. bóc lột sức lao động của trẻ vị thành niên 

B. lợi dụng sức lao động của người khác để trục lợi 

C. giúp đỡ các em nhỏ có việc làm. 

D. vi phạm pháp luật lao động về sử dụng lao động chưa thành niên 

Câu 19: Theo quy định của bộ luật lao động thì độ tuổi lao động là từ bao nhiêu?                                                   

A. Từ đủ 15.           B. Từ đủ 16.                     C. Từ đủ 17.         D. Từ đủ 18     

Câu 20: Theo quy định của bộ luật lao động thì độ tuổi lao động chưa thành niên là bao nhiêu 

tuổi?                                                   

A. Dưới 15.               B. Dưới 16.                     C. Dưới17.                D. Dưới 18                                   

                               

 

 

MÔN TIN HỌC  

 

I/ Trắc nghiệm 

Câu 1: Đặc trưng của các dải lệnh trong phần mềm trình chiếu gồm?  

A. 1 loại   B. 2 Loại         C. 3 loại          D. 4 loại 

Câu 2: Lệnh dùng để tạo các hiệu ứng chuyển động cho các đối tượng trên trang chiếu 

là 

A. SlideShow        B. Animations        C. Transitions         D. Home 

Câu 3: Lệnh dùng để tạo hiệu ứng chuyển tiếp các trang khi trình chiếu là?  

A. Transitions  B. Home         C. SlideShow         D. Design 

Câu 4: Mẫu bố trí nội dung là gì?  

A. New Slide           B. From Beginning        C. Slides                D. Layout 

Câu 5: Trong dải lệnh Design các mẫu định dạng nằm trong nhóm?  

A. Themes   B. Home           C. Font         D. Slides 

Câu 6: Phần mềm trình chiếu có một thư viện ảnh rất phong phú. Thư viện này được 

gọi là? A. Clip Art   B. Photo Album            C. Picture       D. Shapes 
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Câu 7: Các lệnh tùy chọn và tạo hiệu ứng động có trên dải lệnh?  

A. Home   B. Animations            C. Design       D. Insert 

Câu 8: Đa phương tiện là thông tin được kết hợp từ?  

A. 1 dạng   B. 2 dạng             C.3 Dạng       D. Nhiều dạng 

Câu 9: Để trình chiếu từ trang đầu ta ấn phím sau đây trên bàn phím: 

A. Enter             B. F5                       C. Insert       D. Ctrl+F4. 

Câu 10: Sắp xếp các thao tác sau theo thứ tự để đặt màu nền cho trang chiếu: 

          a. Chọn màu thích hợp trên hộp thoại.      b. Chọn lệnh Format -> Background. 

          c. Nháy nút Apply trên hộp thoại.       d. Chọn trang chiếu trong ngăn bên trái. 

      A . c-a-d-b     B. d-b-a-c   C. d-a-c-b  D. b-d-a-c 

Câu 11: Để chèn âm thanh, phim ảnh vào PowerPoint em thực hiện?        

      A. Insert – Slide From File                          B. Insert – Movies and Sound 

     C. Format – Movies and Sound               D. Slide Show – Movies and Sound  

Câu 12: Cách tạo màu nền cho 1 trang chiếu? (0,5 điểm) 

A. Chọn trang chiếuFormat  BackgroundNháy nút    và chọn màu  Apply to All. 

B. Chọn trang chiếuFormat  BackgroundNháy nút    và chọn màu  Apply. 

C. Chọn trang chiếu Insert  BackgroundNháy nút    và chọn màu  Apply to All. 

D. Chọn trang chiếuInsert BackgroundNháy nút    và chọn màu  Apply. 

Câu 13:  Các bước tạo bài trình chiếu ?  

A. Chuẩn bị nội dung cho bài chiếu, Chọn màu hoặc hình ảnh nền cho trang chiếu. 

B. Nhập và định dạng nội dung văn bản,Thêm các hình ảnh minh họa. 

C. Tạo hiệu ứng chuyển động, trình chiếu kiểm tra, chỉnh sửa và lưu bài trình chiếu. 

D. Tất cả đều đúng 

Câu 14: Hãy chọn  thao tác dúng khi em muốn hiển thị mẫu bố trí có sẵn trong ngăn 

bên phải cửa sổ : 

      A.  Chọn lệnh View  Slide Layout.      B.  Chọn lệnh Format  Background. 

      C.  Chọn lệnh Format  Slide Layout. 

Câu 15:  Với các phần mềm trình chiếu, em có thể chèn những đối tượng nào vào trang 

chiếu để minh họa nội dung? 

      A. Các tệp hình ảnh và âm thanh.               B. Các đoạn phim ngắn. 

      C. Tất cả các đối tượng trên. 

Câu 16: Em có thể thực hiện thao tác nào dưới đây với các hình ảnh đã được chèn vào 

trang chiếu? 

      A. Thay đổi kích thước của hình ảnh           B. Thay đổi  màu sắc của hình ảnh 

      C. Thay đổi mẫu của hình ảnh. 

Câu 17: Để mở ngăn Slide Transition và tạo hiệu ứng chuyển trang chiếu, chúng ta sử 

dụng lệnh nào dưới đây?  

A. Slide Show → Animation Schemes. 

B.Lệnh Slide Show → Slide Transition. 

C. Lệnh Edit → Slide Transition. 

Câu 18: Để thêm một trang chiếu mới ta chọn lệnh: 
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         A. File  Exit     B. Insert  New Slide 

         C. Slide  View     D. Format  Slide Layout 

Câu 19: Nên sử dụng các hiệu ứng động ở mức độ : 

 A. Càng nhiều càng tốt.                     B. Mỗi nội dung nên tạo nhiều hiệu ứng. 

 C. Mức độ vừa phải.                           D. Không nên tạo hiệu ứng động. 

Câu 20: Khi trình chiếu nội dung của mỗi trang chiếu:  

 A. Bắt buộc phải có 1 hiệu ứng âm thanh đi kèm. 

 B. Bắt buộc phải có 2 hiệu ứng âm thanh trở lên. 

 C. Tùy theo nội dung thể hiện để chọn âm thanh cho phù hợp. 

 D. Tuyệt đối không nên sử dụng hiệu ứng âm thanh. 

Câu 21:. Cách chèn thêm trang chiếu (slide) mới? 

A. Nháy vào nút New Slide…    B. Insert  New Slide  

C. Nháy phải ở khung bên trái và chọn New Slide D. Cả 3 đều được. 

Câu 22: Để tạo một slide giống hệt như slide hiện hành mà không phải thiết kế lại, người 

sử dụng 

A. chọn Insert -> Duplicate 

B. chọn Insert -> New Slide 

C. chọn Insert -> Duplicate Slide 

Câu 23: Để căn lề cho một đoạn văn bản nào đó trong giáo án điện tử đang thiết kế, trước 

tiên ta phải 

A. đưa con trỏ văn bản vào giữa đoạn văn bản cần căn lề 

B. chọn cả đoạn văn bản cần căn lề 

C. chọn một dòng bất kỳ trong đoạn văn bản cần căn lề 

D. cả 3 cách nêu trong câu này đều đúng 

Câu 24: Muốn xóa slide hiện thời khỏi giáo án điện tử, người thiết kế phải 

A. chọn tất cả các đối tượng trên slide và nhấn phím Delete. 

B. chọn tất cả các đối tượng trên slide và nhấn phím Backspace. 

C. chọn Edit -> Delete Slide. 

D. nhấn chuột phải lên slide và chọn Delete 

Câu 25: Các thao tác có thể thực hiện đối với hình ảnh được chèn vào trang chiếu? 

A. Di chuyển, co giãn, thay đổi thứ tự trên dưới 

B. Thay đổi thứ tự trên dưới 

C. Di chuyển, thay đổi thứ tự trên dưới 

D. Thay đổi kích thước, vị trí, thứ tự trên dưới, độ đậm nhạt, độ sáng tối, cắt xén bớt một 

hoặc nhiều cạnh, xoay, tạo viền, tạo hiệu ứng động… 

Câu 26: Yếu tố nào ảnh hưởng đến tính hấp dẫn, sinh động cho bài trình chiếu? 

A. Màu sắc (màu nền, màu chữ, màu của hình ảnh)                  B. Định dạng văn bản 

C. Hiệu ứng động                                 D. Màu sắc, định dạng văn bản, hiệu ứng động. 

Câu 27: Cách mở mẫu bố trí (slide layout)? 

A. Insert → Slide layout…                             B. Slide Show → Slide layout… 

C. Format → Slide layout…                           D. Tools → Slide layout… 

 

Câu 28: Cách chèn thêm trang chiếu (slide) mới? 
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A. Insert → New Slide                                                         B. Ctrl + M 

C. Nháy phải ở khung bên trái và chọn New Slide               

D. Insert → New Slide, Ctrl + M, nháy phải ở khung bên trái và chọn New Slide.                                                                   

Câu 29: Để di chuyển toàn bộ trang chiếu, em sử dụng cặp nút lệnh nào sau đây: 

 
Câu 30: Cách mở mẫu bài trình chiếu (Slide Design…)? 

A. Insert → Slide Design…                         B. View → Slide Design… 

C. Format → Slide Design…                      D. Tools → Slide Design… 

Câu 31: Hàm tính tổng trong chương trình bảng tính là? 

A. SUM                     B. MIN                      C. AVERAGE                      D. MAX 

Câu 32: Em có thể chèn hình ảnh vào trang chiếu bằng cách nào? 

A. Insert → Text box;                                 B. Format →Font; 

C. Insert → Picture→ from file…;              D. Edit → Select All. 

Câu 33: Khi Slide xuất hiện đối tượng chọn hiệu ứng chưa xuất hiện em chọn nhóm hiệu 

ứng sau đây 

A. Exit                         B. Emphasis           C. Entrance                           D. Motion Path 

Câu 34: Để đối tượng chọn hiệu ứng được nhấn mạnh nổi bật hơn em chọn nhóm hiệu ứng 

sau đây 

A. Entrance                  B. Emphasis                C. Exit                          D. Motion Path 

Câu 35: Để đối tượng chọn hiệu ứng di chuyển đến vị trí mới em chọn nhóm hiệu ứng 

A. Exit                           B. Motion Path             C. Entrance                    D. Emphasis 

Câu 36: Để hiệu ứng thực hiện đồng thời với hiệu ứng trên nó em chọn 

A. On Click                B. After Previous                    C. With Previous      D. Delay 

Câu 37. Để tạo hiệu ứng cho các đối tượng trên trang chiếu ta vào: 

A. Slide Show \ Animation Schemes                    B. Slide Show \ Custom Animation 

C. Slide Show \ Slide Transition                           D. Slide Show \ Animation Transition 

Câu 38. Để trình diễn một Slide trong PowerPoint, ta bấm: 

A. Phím F5                  B. Phím F3                  C. Phím F1                  D. Phím F10 

Câu 39. Khi đang làm việc với PowerPoint, để chèn thêm một Slide mới, ta thực hiện: 

A. Edit – New Slide                                             B. File – New Slide 

C. Slide Show – New Slide                                 D. Insert – New Slide 

Câu 40: Một bài trình chiếu gồm có 5 trang chiếu. Từ trang thứ 2 trở đi được gọi là trang 

gì? 

A. Nội dung trang                                                   B. Trang nội dung 

C. Tiêu đề trang                                                      D. Trang tiêu đề 

Câu 41: Các hiệu ứng động làm cho việc trình chiếu trở nên? 

A. Hấp dẫn, sinh động và thu hút sự chú ý.          B. Không thuận tiện. 

C. Không cần thiết.                                               D. Không hứng thú. 

Câu 42: Tên phần mềm nào sau đây là phần mềm trình chiếu? 

A. Unikey                                                             B. Microsoft Excel 

C. Microsoft PowerPoint                                      D. Microsoft Word 

Câu 43: Công cụ nào dưới đây được xem là công cụ hỗ trợ trình bày hiệu quả nhất? 

A. Biểu đồ được vẽ trên khổ giấy lớn               B. Vở và bút viết 

C. Máy tính, phần mềm trình chiếu                   D. Microphone 
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Câu 44: Để chèn âm thanh, phim ảnh vào PowerPoint em thực hiện 

A. Insert – Slide From File                              B. Format – Movies and Sound 

C. Insert – Movies and Sound                          D. Slide Show – Movies and Sound 

Câu 45: Tên phần mềm nào sau đây là phần mềm trình chiếu? 

A. Unikey                                                   B. Microsoft Excel 

C. Microsoft PowerPoint                           D. Microsoft Word 

Câu 46: Chúng ta gọi một cách ngắn gọn các nội dung trên các trang chiếu là 

A. Văn bản             B. Hình ảnh                  C. Âm thanh                  D. Đối tượng 

Câu 47: Để cài đặt hiệu ứng cho từng đối tượng em chọn 

A. Slide Show – Custom Animation – Add Effect     B. Slide Show – Setup Show - Add Effect 

C. View – Custom Animation – Add Effect              D. Slide Show – Slide Transition – Add Effect 

Câu 48: Để dụng màu nền cho toàn bộ trang chiếu thì nháy vào nút lệnh nào sau đây? 

A. Apply;                                                B. Apply to All; 

C. Apply to Selected;                              D. Apply to all Slide. 

 

 

 

MÔN CÔNG NGHỆ  

I. Trắc nghiệm:  

Câu 1. Lắp đặt mạch điện  hai công tắc hai cực điều khiển hai đèn cần có các thiết bị: 

A . Một cầu chì, hai công tắc hai cực, hai bóng đèn   

B . Hai cầu chì, hai công tắc, hai cực hai bóng đèn  

C . Ba  cầu chì, hai công tắc hai cực, hai bóng đèn    

D . Bốn cầu chì, hai công tắc hai cực, hai bóng đèn   

Câu 2. Đồng hồ điện được dùng để đo điện trở mạch điện là. 

A. Oắt kế                  B. Am pe kế              C. Ôm kế                    D. Vôn kế 

Câu 3. Dây  dẫn không được buộc lại với nhau vì: 

A . Không thuận tiện khi sử dụng. B. Để dễ dàng cho việc kiểm tra mạng điện. 

C . Để tránh nhiệt độ tăng, làm hỏng lớp cách điện.     D. Không đảm bảo mỹ thuật 

Câu 4. Công tắc ba cực gồm có các cực sau: 

A . Hai tĩnh, một động.                                           B. Một tĩnh, một động.   

C . Hai động, một tĩnh.                                D . Tất cả đều đúng. 

Câu 5. Mạch điện cầu thang là tên gọi của mạch điện: 

A . Đèn huỳnh quang                            B. Một công tắc ba cực điều khiển  hai  đèn. 

C . Hai công tắc hai cực điều khiển hai đèn    D. Hai công tắc ba cực điều khiển một đèn.  

Câu 6 . Việc nào sau đây em cho là đúng ? 

A. Thả diều gần dây điện .                    B. Nối đất các thiết bị có vỏ bằng kim loại. 

C. Buộc trâu bò vào chân cây cột điện  D. Dùng điện đánh chuột . 

Câu 7. Vai trò của cầu chì trong mạch điện: 

A. Ngắt mạch điện khi dòng điện quá mạnh, tránh sự cố nguy hiểm về điện. 

B. Để đảm bảo về thẩm mĩ. 

C. Đảm bảo về số lượng thiết bị. 

D. Tăng dòng điện trong mạch. 
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Câu 8. Kí hiệu nào sau đây là kí hiệu của công tắc hai cực: 

 

 

 

 A.                 B.                        C.   D.  

Câu 9. Có một mạch điện gồm 1 đèn muốn đóng, ngắt mạch ở 2 nơi ta phải dùng: 

 A. Hai công tắc 3 cực.       B. Hai công tắc 2 cực. 

 C. Một công tắc 3 cực, 1 công tắc 2 cực.       D.  Một công tắc 2 cực 

Câu 10. Quy trình lắp đặt mạch điện hai công tắc ba cực điều khiển một bóng đèn, người 

ta vạch dấu vị trí: 

A. Vạch dấu vị trí thiết bị điện                            

B. Vạch dấu vị trí đèn 

 C. Vạch dấu đường đi dây của mạch điện          

 D. Vạch dấu vị trí thiết bị điện, vị trí đèn, đường đi dây của mạch điện.                              

Câu 11. “Khoan lỗ bắt vít” là nội dung trong bước nào của quy trình lắp đặt mạch điện: 

A. Vạch dấu.                                                    C. Khoan lỗ. 

B. Nối dây mạch điện.                                     D. Kiểm tra.  

Câu 12. Quy trình lắp đặt mạch điện hai công tắc ba cực điều khiển hai đèn thì “Vạch 

dấu” thuộc bước: 

A. 4                              B. 3                                C. 2                                   D. 1 

Câu 13. Quy trình lắp đặt mạch điện hai công tắc hai cực điều khiển hai đèn gồm: 

A. 3 bước.                   B. 4 bước.                       C. 5 bước.                    D. 6 bước. 

Câu 14. Lắp mạch điện hai công tắc ba cực điều khiển một bóng đèn cần dụng cụ: 

 A. Kìm tuốt dây                                                   B. Dây dẫn trần. 

 C.  Kìm tuốt dây, tua vít                                      D. Dây cáp. 

Câu 15. Các dụng cụ cần thiết trong bước Nối dây mạch điện là: 

A. Kìm tuốt dây, kìm điện, băng dính                B. Thước, mũi vạch hoặc bút chì 

C. Bút thử điện                                                    D. Tua vít, kìm 

Câu 16. Công tắc hai cực và công tắc ba cực có cấu tạo bên ngoài: 

A. Khác nhau.                                                      C. Giống nhau. 

B. Không so sánh được.                                      D. Giống cầu chì. 

Câu 17. Sau khi lắp đặt mạch điện thì sản phẩm cần đạt các tiêu chuẩn nào: 

A. Lắp đặt đúng theo sơ đồ.                            

B. Các mối nối đảm bảo an toàn điện, chắc và đẹp. 

C. Mạch điện đảm bảo thông mạch. 

D. Lắp đặt đúng theo sơ đồ,  các mối nối đảm bảo an toàn điện, chắc và đẹp, 

mạch điện đảm bảo thông mạch.               

Câu 18. Ở quy trình lắp đặt mạch điện hai công tắc hai cực điều khiển hai đèn thì “Kiểm 

tra” thuộc bước: 

 A. Bước 2                       B. Bước 3            C. Bước 4                D. Bước  5 

Câu 19. Công tắc hai cực được mắc vào mạch điện như sau: 

A. Mắc nối tiếp với cầu chì.          B. Mắc nối tiếp với đèn, không qua cầu chì. 
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B. Mắc song song với cầu chì.          D. Mắc song song với đèn. 

Câu 20.  Vẽ sơ đồ lắp đặt mạch điện hai công tắc hai cực điều khiển hai đèn được tiến 

hành theo mấy bước: 

A. 3 bước                     B. 4 bước                C. 5 bước                    D. 6 bước. 

      II. Tự luận: 

Câu 1: Trình bày tác dụng của cầu chì trong sơ đồ mạch điện? 

Câu 2: Nêu quy trình lắp đặt mạch điện hai công tắc hai cực điều khiển hai bóng đèn và 

mạch điện hai công tắc ba cực điều khiển một bóng đèn. 

Câu 3: Hãy vẽ sơ đồ lắp đặt của mạch điện: 

a. Mạch điện hai công tắc hai cực điều khiển hai bóng đèn. 

b. Mạch điện hai công tắc ba cực điều khiển một bóng đèn. 

       Câu 4: Đối với mạng điện lắp đặt kiểu nổi, có các phụ kiện nào đi kèm theo ống luồn dây cách  

       điện? Kẹp đỡ ống được dùng để làm gì? 

 

- Hết – 

 

Chúc các em ôn tập tốt và thi tốt ! 

 


